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Multi-site checklist

Follow this checklist when implementing a new multi-site system. Each step has a corresponding
chapter that describes the step in detail.

WhereDescriptionStep

N/APlan:

• See the Multi-Site Planning Guide and create spreadsheets and
flowcharts.

• Decide whether transactional or non-transactional replication will be
used.

1

Database serv-
er

Set up the database server:

• Install Infor CloudSuite Business and create one application database.
• Depending on how you plan to set up your system, either create ad-

ditional application databases for sites, or add sites to your existing
application database. Use the Infor CloudSuite Business Configuration
Wizard.

• If you are using one site per database, use the Infor CloudSuite
Business Configuration Wizard to link the databases.

• If you are using multiple sites per database, add or copy the additional
sites/entities into the application database.

2

Utility serverSet up the utility server:

• Install and configure Infor CloudSuite Business.
• Create additional client configurations for other sites - Infor CloudSuite

Business Configuration Wizard.
• Add web servers used by the configurations.
• Define configuration groups.
• Update Service Configuration Manager utility settings to handle these

tasks:
• Set up monitoring of configurations for events
• Set up monitoring of configurations by TaskMan
• Set up a replication configuration (non-transactional only)

• Restart the services.
• Use one console to administer all sites.

3

Utility server or
client machines

Set up end user clients.4

Infor CloudSuite Business Multi-Site Implementation Guide | 7

 

Multi-site checklist



WhereDescriptionStep

Sites

(including enti-
ties)

Set up transactional replication:

• Set up replication links on the Intranets form and Sites or
Sites/Entities form.

• Update views and triggers if linked sites are in different databases.
• Set up replication categories and rules on the Replication Categories

form and Replication Rules form, and regenerate triggers on the
Replication Management form.

• Populate parameter _all records at other sites.

5.A

Sites

(including enti-
ties)

Set up a master site:

• Set up transactional replication (above).
• Set up the master site using the Intranets form and Sites or

Sites/Entities form.
• Set up shared _all tables on the Intranet Shared Tables form.

5.B

Sites

(including enti-
ties)

Set up non-transactional replication:

• Create replication user with the Users form and the User Modules
form (requires license).

• Set up system types on the System Types form.
• Set up replication links on the Intranets form and the Sites or

Sites/Entities form.
• Update views and triggers if linked sites are in different databases.
• Set up replication categories and rules using the Replication Cate-

gories form, the Replication Rules form, and the Replication
Managementform.

• Populate parameter _all records at other sites.

5.C

Sites

(including enti-
ties)

Set up licensing:

• If you use intranet licensing, turn it on at the master site and any
participating sites, using the Sites or Sites/Entities form.

• Set up license modules for a database on the License Management
form.

• Enable modules for a site on the Optional Modules form.

6

Sites and Low-
er-level Entities

Set up the financial reporting hierarchy on the Change Reports To
Entity form.

7. A
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WhereDescriptionStep

Top-level EntitySet up accounts on these forms:

• Multi-FSB form (optional)
• Chart of Accounts form: Add all accounts; add CTA account
• Multi-Site Chart Copy form: Copy Chart of Accounts to mid-level

entities
• Unit Code 1-4 forms
• Copy Unit Codes to Accounts form
• Accounting Periods form

Set up financial statements using the Financial Statement Definition,
Financial Statement Definition Columns, and Financial Statement
Line Definition forms.

7. B

Mid-level Enti-
ties

Set up accounts on these forms:

• Multi-FSB (optional)
• Chart of Accounts form: Specify Reports To account information
• Unit Code 1-4 forms
• Copy Unit Codes to Accounts form
• Accounting Periods form
• Verify Accounts To Report form

Set up financial statements (only if mid-level entities will run them).

7. C

SitesSet up accounts on these forms:

• Multi-FSB (optional) form
• Chart of Accounts form: Delete accounts that do not apply
• Unit Code 1-4 forms
• Copy Unit Codes to Accounts form
• Accounting Periods form - just specify current period

Set up financial statements only if sites will run the reports.

7. D

Sites and enti-
ties (some infor-
mation will repli-
cate)

Set up parameters and codes needed for later steps:

• Set up site groups on the Site Groups form.
• Set up countries and states on the Countries and Prov/States forms.
• Set up currency on the Multi-Currency Parameters, Currency

Codes, and Currency Rates forms.
• Set up parameters on the General Parameters form.

8. A

SitesSet up bank codes on the Bank Reconciliations form.8.B
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WhereDescriptionStep

SitesSet up system parameters on these forms:

• Inter-Site Parameters form
• Accounts Receivable Parameters form
• Accounts Payable Parameters form
• Order Entry Parameters form
• Purchasing Parameters form
• Transfer Order Parameters form
• Planning Parameters form
• Inventory Parameters form
• Other parameter forms as needed

8.C

Sites

(including enti-
ties)

Set up users and authorizations:

• Set up sharing of user tables at the master site on the Intranet
Shared User Tables form (optional).

• Set up other users on the Users form, Object Authorizations for
Users form, and User Modules form.

If you use intranet licensing, run User Modules only at the master
site.

• Set up any external customers or suppliers who will log in remotely
via the internet as users on particular sites.

9

SitesSet up supporting data.

See the list of forms in Setting up supporting data on page 72. The forms
you use depend on your company’s requirements.

10

SitesSet up operational data:

• Add common customers on the Customers for Multi-Site Customers
form.

• Add common vendors on the Vendors or Multi-Site Vendors form.
• Add common items on the Items, Multi-Site Items, or Global Items

form.
• Set up employees on the Employees form.
• Set up other operational data. See the list of forms in Setting up op-

erational data on page 74. The forms you use depend on your com-
pany’s requirements.

11

Depends on the
product

Set up add-on products and modules.9

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal.
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If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1: Planning

Follow these steps to plan your multi-site implementation:

1 See the Infor CloudSuite Business Multi-Site Planning Guide. When you complete the steps in that
guide, you will have spreadsheets and flowcharts containing most of the information that you need
to install and configure your sites. You can then update the spreadsheets to track changes as your
system grows.

2 You must know which type of replication you are using before you set up your system, because
some steps apply only to one type or the other:
• Non-transactional replication, as used in this guide, refers to any inbound or outbound

asynchronous replication.

This can include applications that integrate with CloudSuite Business by posting data via XML
(BOD) documents into the CloudSuite Business sites, as well as CloudSuite Business sites using
XML to communicate with each other.

CloudSuite Business Enterprise Financials and EAM would fall into this category.

• Transactional replication, as used here, generally means that sites are on the same database
server and are replicating records through database triggers and stored procedures as soon as
the records are added or changed on one site. The use of master sites requires much of the
same setup as transactional replication.

3 We recommend that you set up a test environment and ensure that everything works properly before
you set up your production environment.

See Setting up a test environment on page 93.
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Chapter 2: Setting up the database server

Follow these steps to set up the database server.

Installing the application and creating an application
database with one site
Note:  If you plan to set up multiple sites in one database, your database server must be running
Microsoft SQL Enterprise Server and the database you create is automatically partitioned.

On each SQL server machine where you will be adding site databases, follow the steps in the Infor
CloudSuite Business Installation Guide chapter "Setting Up the Database Server" to install the application
and perform these actions:

• Create one initialized application database.

If you plan to set up multiple sites in one application database, name the database appropriately,
taking into account any other sites or entities that you plan to add to it.

• Use your SiteEntity spreadsheet (from the planning phase) to enter the site information when
configuring the application database.

• Create at least one forms database for your system. Your SiteEntity planning spreadsheet should
indicate how many forms databases you need and what to name each one. Later, on the utility
server, you will specify which forms databases are used with which application databases.

• Create at least one objects database for your system. The SiteEntity planning spreadsheet should
contain the information you need for this. Later, on the utility server, you will specify which objects
databases to use with each application database.

If you plan to set up multiple sites per database, only one objects database is allowed for those
sites.

After you create one application database, one forms database, and one objects database, return to
this chapter to perform additional steps.

At this point, you must choose one of these options:

• Create additional sites and entities in separate databases and link them together. Continue with
Creating additional site databases on page 14.

• Create additional sites and entities in the same application database. Skip to Adding new sites and
entities to an existing application database on page 16.
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Creating additional site databases
Add multiple application databases on each database server, with one site or entity in each database.

1 Run the Configuration Wizard again. (Run as Administrator.)

2 Select the Advanced option and click Next.
3 Select Create Databases and click Next.
4 To add all of the application databases in one session, just click the Add Database button after you

define each database.

a In the Database Type list, select Initialized Application Database. This is true for either site
or entity databases. (You would only choose Empty Application Database instead if you are
migrating from a Progress database, or if you are upgrading from a SQL version of CloudSuite
Business and are copying multiple sites into a single database.)

b To provide the database name and connection information, refer to your SiteEntity planning
spreadsheet.

c Click Next to display summary information for each of the new databases.

5 Click Commit to commit the configuration changes. If you are creating several databases, this step
may take some time to complete.

6 Click Finish to close the wizard.

Linking databases
Note:  Perform the steps in this section only if you plan to use transactional replication to replicate data
to or from sites in application databases located on this database server.

After you have defined all your databases, link them so they can communicate with each other:

1 Run the Configuration Wizard again. (Run it as Administrator.)

2 Select the Advanced option and click Next.
3 Select Link Databases for Multi-Site Use and click Next.
4 In the Group Name field, specify a name for the set of sites on this machine that you want to link

together. Use the group name from your SiteEntity spreadsheet
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Every time you run the Configuration Wizard, the first time you display this screen, the list of sites
will be blank - even if linked databases already exist in the group you specify. To add a new site to
an existing group, you must re-add all of the sites here. This sets up each database for multi-site
communication and links it to all of the other databases that are added at the same time.

Later, in the application’s Site Groups form, you can add more groups or change the groups to
which a site belongs.

5 For each site that you want to be linked, specify this connection information for the database and
click Add:

SQL Server Name
Specify the name of the SQL Server where the application database you want to link to resides.

SQL Username and Password
Specify the name and password of a SQL user who can access and update this database.
Sometimes this is set up as the sa user.

Database to Link
Specify the name of one of the application databases to be linked. (You will be adding the others
in the next step.)

Site ID
Select a site ID in the database you specified. For single-site databases, the site or entity ID displays.

Site Description
The description of the database you specified is shown.

Ensure that you link only application databases, not forms or objects databases.

6 When all of the sites that you want to link are listed, click Next.
7 Review the changes and click Commit.
8 Click Finish to close the wizard.
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Each time you run the Configuration Wizard on either the database server or the utility server, it
appends information about the configuration changes to a log file found on that server:

Infor\SyteLine\Tools\ConfigWiz.log.

9 If you plan to perform transactional replication between sites on this database server and other sites
that are not on this database server, create a linked server definition in the SQL server master
database of both the current site and the To site. Do this with the SQL Server Management Console:
in the console tree, open the Server Objects folder for the server and right-click on the Linked Servers
node. This should match the list of linked servers you added in the Configuration Wizard.

If all sites are on one database server, or if you are not using transactional replication, you can skip
this step.

About linking databases
Whenever you add a new site to an existing transactional multi-site environment, you must relink all
sites using the Configuration Wizard. If you create and configure the new site by itself, it will prepare
that database for multi-site work, but it will not know about other existing databases.

Although the databases do not all have to be on the local server, transactional replication is much more
efficient when they reside on the same server.

You can run the wizard again to add more links later if needed.

When you link multi-site databases with the Configuration Wizard, the following things are altered in
the databases:

• site table: new entries are added or updated.
• *_all tables: row pointers are altered, foreign keys are temporarily dropped, tables are truncated

and repopulated, and foreign keys are reapplied.
• ApsResyncAllSp runs against each database.
• site_group table: new entries are added or updated.
• site_live_link table: new entries are added or updated.

If you plan to use transactional replication between all the sites and entities in each reporting hierarchy
or intranet, but also use non-transactional replication between sites in different reporting hierarchies
or intranets, you should create a group for each reporting hierarchy or intranet and link together the
sites/entities in each group. So you would run the wizard multiple times to create multiple linked groups.

Adding new sites and entities to an existing application
database
Use your SiteEntity spreadsheet (from the planning phase) to enter the site information when adding
and configuring sites and entities.

Infor CloudSuite Business Multi-Site Implementation Guide | 16

 

Setting up the database server



To create a new site or entity in the application database you created earlier in this chapter:

1 Prevent users from accessing or making any changes in the target databases during this process.

2 Open the Configuration Wizard. (Run as Administrator.)

3 Select the Advanced option and click Next.
4 Select Add New Site to an Existing Database and click Next.
5 Select Initialized Application Site and specify this information for the site, from the information in

your SiteEntity planning spreadsheet:

Site ID
Specify an ID, which can be a shorter version of the site name (8 characters maximum).

Site Name
Specify a name for the site.

Site Description
Specify a description for the site environment that is to be created.

Site Group
Specify a group name for the environment being created. The group name should be descriptive
of the sites in the group. For example, you might have a group name of NoAm for North America if
all the sites in that group are in North America.

Site Currency
Accept the default value of USD or specify the appropriate currency code for the environment.

Site Type
In most cases, accept the default value of Site. Select Entity if you are setting up a financial
entity to consolidate data from the sites.

Time Zone
Specify the time zone for the site.

6 Click Next.
7 Specify the database connection information for the application database that you created earlier.

Do not select Analyze Only; that field applies only when you copy existing sites from other databases.

Do not select Delete Target Database Data; that field applies only if you want to empty the data
from the specified target database. This is only necessary in the specific case described in Steps
on page 108.
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8 Click Next.
9 Review the changes and click Commit.
10 Click Finish.

11 To add more sites or entities to the application database, reopen the Configuration Wizard and
repeat these steps.
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Chapter 3: Setting up the utility server

Follow these steps to set up the utility (application) server.

Installing the application and configuring components
On each utility/web server machine where you will be creating configurations, follow all the steps in
the Infor CloudSuite Business Installation Guide chapter "Setting Up the Utility Server." These steps
are performed:

• Install the application.
• Create an initial configuration on the utility server that links to one site database, using one of the

configuration names you specified during your planning phase.
• Set up the various web services (IIS-based) on the utility server. These are used by clients connecting

using http protocol, by the online help, for non-transactional replication, for integration with some
applications, and so on.

• Set up web rendering, if appropriate.
• Set up the TaskMan service for the utility server.
• Set up replication services on the utility server.

Note:  Replication services are needed only if any of the configurations to be defined on this utility
server will be running non-transactional replication.

• Set up a Planning and Scheduling gateway and server (used only with APS).
• Set up Reporting Services so that you can print and preview reports.
• Set up the Application Search Web service, if appropriate.
• Through the Service Configuration Manager, set up monitoring of that first configuration by the

TaskMan, replication, and event services.
• Set up an administrative client on the utility server that points to a specified URL. This URL is the

utility/web server where the various configurations will be defined.

Then return to this guide and perform the next steps to create configurations for the rest of your sites.
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Creating additional client configurations
You must add a client configuration for each site database that you want to access through this
application/web server.

Caution:  If you have multiple application servers, only one of them should be designated as the
configuration server, and the Configuration Manager utility should be run only on that configuration
server. The resulting MongooseConfigs.xml file should then be copied to the other servers so they
have access to the defined configurations. See the Infor CloudSuite Business Multi-Site Planning
Guide for information about the configuration server.

For each site, create one configuration name that exactly matches the site ID, including case, and that
uses the site’s application database. This is required unless you specify a different default Configuration
Name on the Sites or Sites/Entities form. (You can create additional configurations for the site, with
different names.)

1 On the application server, find and open the Configuration Manager, under Apps (Run as
Administrator).

The Configuration Manager displays the initial configuration that was created during installation and
setup of the application/web server.

2 Click New to create a new configuration.

3 Specify the new configuration name and click OK
4 In the Runtime (Client) tab, specify the application and forms database connection information for

the new configuration.

Note:  For an all-in-one database, the specifications for the application, forms, and objects databases
will be the same.
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Use the information from your SiteEntity and Configurations planning spreadsheets to help you fill
in access information (SQL server name, login, password, and database name) for the application,
forms, and objects databases.

5 In the Objects Metadata tab, click Set Objects DB Specification and then specify the Objects
database name.

You can associate only one Objects database with an application database.

By default, if you have multiple sites in one application database, all configurations for sites in that
database should point to the same Objects database.

6 Click OK. A confirmation message displays; click OK again.

7 If you use FormControl or a source control system, set up information on those tabs as needed.

8 Click the OK button at the bottom of the Edit Configuration screen to save the configuration and
return to the Configurations tab, where the new configuration displays.

9 Repeat steps 2-8 until all configurations are defined.
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Note:  If a new configuration definition will be very similar to an existing one, you might want to use
Copy instead of New. This creates a copy with a new configuration name and you then select Edit to
modify the definition.

Adding web servers that are used by the configurations
If you have multiple application servers through which your clients can access the configurations, define
them in the Web Servers tab of the Configuration Manager. They will be accessed in round-robin order
as session requests come in to the Configuration Server. (See the caution in Creating additional client
configurations on page 20 about running the Configuration Manager utility only on the Configuration
Server.)

Note:  Do not include DMZ servers in this list.

1 In the Web Servers tab of the Configuration Manager, click New.

2 Specify a logical name for the web/utility server, and click OK.

3 Specify the http address of the web/utility server and click OK.

The server is added to the list of web servers that the configurations can access.

Defining configuration groups
You should have determined during the planning phase whether you will have multiple configuration
groups. If so, select the Configuration Groups tab in the Configuration Manager utility.

Click New or Edit to display a dialog where you can define new groups and add configurations to them.
The configurations must already be defined on the Configurations tab.

Configuration group names can contain only alphanumeric characters and the underscore character.

The Default group is predefined and cannot be deleted (but it can be edited). This group initially contains
every configuration. If there are no configuration groups defined in your current configuration file
(MongooseConfigs.xml), you will still see the Default group containing all configurations. Whenever
you create a new configuration, it is added to the Default configuration group. If clients request
configurations and do not specify a configuration group (or specifies "Default"), they will be presented
with only configurations in the Default group.
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Updating Service Configuration Manager settings
When you add configurations, you need to update the Service Configuration Manager utility so that
the new configurations will be monitored by Infor services such as TaskMan, Replication, and the Event
System.

Find and open the Service Configuration Manager under the Apps area on the application server. (Run
as Administrator.)

The General tab shows what services are installed on this utility server and where to find configuration
files. You can also specify a default configuration here, but currently it only applies to the Replication
services.

Use the Config Server URL field to specify the URL to the configuration server.

Setting up event monitors for configurations
Use the Event Service tab on the Service Configuration Manager to specify each of the configurations
you want the Application Event System to monitor.

See the Multi-Site Planning Guide for information about monitoring configurations for events. You might
have created an Events spreadsheet as part of your planning process.
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1 On the Event Service tab, click Add to display a dialog box where you can select a configuration
and optionally specify sleep time (defaults to 10 seconds) and the maximum number of concurrent
events that can run in this configuration (defaults to 5).

For more information, see the Service Configuration Manager online help.

2 Repeat Step 1 for all configurations you want the Application Event System to monitor. Usually you
will select all configurations for monitoring.

3 Click Save to save your changes. The changes you made are not recognized until you stop and
restart the services later.

Setting up TaskMan monitors for configurations
Set up TaskMan to monitor configurations for any application database on which users will be executing
reports, stored procedures, IDO methods, executables, or other background tasks.

Include entity application databases, because financial reports can be run on them.

See the information on TaskMan monitoring of sites in the Multi-Site Planning Guide.

1 Go to the TaskMan tab of the Service Configuration Manager.

2 Click Add to display a dialog box where you can select a configuration and optionally a DSN. (DSNs
are only needed for some custom reports created in previous versions. See the Service Configuration
Manager online help for more information.)

3 Click OK. The configuration is added to the list in the TaskMan tab.

4 Repeat steps 2 and 3 until you have added all the configurations you want TaskMan to monitor.

5 Click the Save button at the bottom of the window to save your changes. The system will not
recognize the changes until you stop and restart the services later in this chapter.

Setting up replication and BOD options
On the Replication tab, configure the options used in non-transactional replication and in BOD
replication.
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Refer to the online help for this tab of the Service Configuration Manager for details on how to set up
these fields. Be aware of this information:

• If any of the configurations defined on this utility server will be running non-transactional replication,
click the Add button next to the Replicator/Inbound Bus Configuration field to create a list of all
of the configurations that can receive inbound or outbound messages from other sites on the intranet.
The Replication Document Outbox form at each site collects outbound BODs for that site. The
Replication Document Inbox form at each site collects inbound BODs for that site.

See the definition of non-transactional replication in Planning on page 12.

If you are upgrading from a previous version and you already have replication set up through a
"bootstrap" site, it will still work as it did in the previous version. The Replicator/Inbound Bus
Configurations field contains one site set as the Master Site, and the ReplQListener Queue
Servers field has the Default field selected.

• The Inbound Bus Service can be installed multiple times on the same computer, in order to run it
against a particular configuration that is specified at installation. However, setting a list of
configurations to monitor, as described above, is the preferred method.

• If you set up a default configuration on the General tab, the application uses that configuration as
the replicator configuration if you don’t specify a different configuration here.

• Click the Add button next to the Replication Queue Listener Servers field to set up a queue server
name for every intranet in your system.

Generally, the queue server name is set to localhost\private$ which uses the standard private
message queues named inbound and outbound on the utility server. However, if you have specified
a Queue Server Name on the Intranets form, that name is used to build a path. For example,
utilityserver3\private$\MyQueues results in the use of the queue names MyQueues_inbound and
MyQueues_outbound.

• Click Save to save your changes. The changes you made are not recognized until you stop and
restart the services later.
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Stopping and restarting services
On the utility server, stop and restart the services so that they will be aware of any updates made in
the Configuration Manager.

1 Select Adminstrative Tools > Services.

2 Right-click on the Infor Framework IDO Runtime Service and select Stop. A message displays
to tell you that stopping this service will also stop other dependent Framework services.

3 Click OK.

4 When the services are stopped, restart them again, starting the Infor Framework IDO Service first.

Note:  It might be simpler to just restart the utility server machine. This automatically stops and
starts all the services.

About the services
This table describes the services.

When to stop or startService name

When you add, edit or delete configurations, or change which con-
figurations are monitored, you must stop and restart these services
so they recognize the changes.

If you change any of this information for a site, you must restart the
TaskMan service: Forms Database Name, Intranet Name, Polling
Interval, Maximum Concurrent Tasks, Maximum Concurrent Report
Tasks, Report URL, TaskMan Path

If you change any of this information, you must restart the replication
services: the Intranet Name for a site, other non-descriptive infor-
mation about the site or intranet, or the password for a user who is
set up in the Sites or Sites/Entities form for use in non-transactional
replication.

Infor Framework Event Service

Infor Framework Replication
Queue Listener

Infor Framework Replicator

Infor Framework TaskMan

Stopping the IDO Runtime Service also stops all dependent services
(Event, Inbound Bus, Replication Queue Listener, Replicator, and
TaskMan). When restarting the services manually, start the IDO
Runtime Service first.

Infor Framework IDO Runtime
Service

This service is not affected by configuration changes. The Inbound
Bus Service now looks at the same configuration list as the Repli-
cator Service.

Infor Framework Inbound Bus
Service
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Using one console to administer all sites
You should be able to log in to client configurations for each site from a single console. This will simplify
the setup and administration of your multi-site system.

If some of your sites are on a remote application server, set up a remote client configuration as described
in the Infor CloudSuite Business Installation Guide chapter on setting up clients.
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Chapter 4: Setting up end user clients

See the Infor CloudSuite Business Installation Guidefor information about how to tell users to set up
smart clients or web clients.

Users of each site must have access to an end user client configuration for that site.

Logging in
1 Using the administrative client on each application server, start CloudSuite Business. Use the

shortcut on the desktop, or use the appropriate client option under Infor on the All Programs menu.

2 Select the configuration for that site, and log in as sa. Specify the password that was defined for
the sa user during CloudSuite Business database server setup. This is the default password for the
CloudSuite Business sa user; you can change it in the application later.

3 If you will be administering several site configurations from a single console, you might want to
display the site configuration name in the window’s title bar. This helps you keep track of which site
you are currently working in. To set this up, select View > User Preferences from the CloudSuite
Business toolbar. In the User Preferences dialog, select Show configuration name on caption.

Specifying a configuration group for a client
When users start CloudSuite Business, they are presented with a list of configuration names to select
from. If you set up configuration groups through the Configuration Manager utility, then you can specify
a group name as part of the client connection information:

• If a client is using a WinStudio shortcut, you can specify the configuration group name using the
-gconfig-group command line option. For example:

WinStudio.exe -gAcme

• If a client is connecting to the Configuration Server using HTTP, the configuration group can be
specified as a query parameter in the URL. For example:

http://slutil/IDORequestService/ConfigServer.aspx?ConfigGroup=Acme
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• If you are using XML to connect, you can specify the configuration group name as part of the
GetConfigurations IDO request. For example:

<IDORequest>
<RequestHeader Type="GetConfigurations" ConfigGroup="Acme"/> 
</IDORequest>

Specifying other startup parameters for a WinStudio
client
If a client is connecting using a WinStudio shortcut, you can specify additional startup parameters as
described in the help topic about WinStudio startup parameters.

Infor CloudSuite Business Multi-Site Implementation Guide | 29

 

Setting up end user clients



Chapter 5: Setting up replication at sites

During the planning phase, you should have determined which type of data sharing you will use, and
which categories of data will be replicated or shared. See these sections for information about setting
up the appropriate type of data sharing:

• See Setting up transactional replication on page 30.
• To set up a master site, first follow the steps for setting up transactional replication. Then see Setting

up a master site on page 35.
• See Setting up non-transactional replication on page 38.

For detailed information about how replication works, see the Infor Mongoose Replication Reference
Guide.

Setting up transactional replication
Note:  Skip this section if you are not using transactional replication.

See the definition of transactional replication in Planning on page 12.

Log into each site as the system administrator and perform these steps. See the online help on the
various forms for more information about any step.

Defining intranets for use with transactional replication
1 In the Intranets form, specify all intranets to be used in this multi-site system. The default intranet

is DEMO. During the planning phase you should have determined whether you need additional
intranets, and which sites will use them.

Some forms, like this one, open “filter-in-place,” where all of the fields on the form are blank. You
can then specify filter criteria in one or more fields to retrieve a collection of records that meet those
criteria. Alternatively, you can leave all fields blank and click the filter button in the toolbar to see all
existing records and add new ones.

2 If you will be sharing _all tables and using a master site, define an intranet that will include all the
sites that share tables. This cannot be an "External" intranet. All the sites on this intranet must use
the same version of CloudSuite Business.

We recommend that you specify a new intranet, not the default DEMO intranet, for this purpose.
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Do not define the master site for the intranet yet. That task is performed later.

3 In the TaskMan Path field for each intranet, specify the shared path to the folder containing
TaskMan.exe on the utility server used by that intranet.

This path is usually set to \\servername\SyteLine.

For more information about how this field is used, see the Multi-Site Planning Guide information on
TaskMan monitoring.

Whenever you change the TaskMan Path, you should restart all TaskMan services that monitor
configurations for application databases connected to this intranet.

Defining linking between sites for transactional replication
Use the Sites or Sites/Entities form to specify information about this site and the other sites that it
communicates with.

1 On the Sites or Sites/Entities form, ensure that each site that was linked to the current site has a
record in this form. See Linking databases on page 14. This record creation should happen
automatically.

2 On the System Info tab, select the record for each site and perform these steps:

a Ensure that the Type, Time Zone, Database Name, and Forms Database Name are set correctly.
b Set the Intranet Name to one of the intranets you defined. See Defining intranets for use with

transactional replication on page 30.
c In the Configuration Name field, specify the name of a configuration that the system will use

as the target configuration when building IDORequest XMLs during replication and AES event
handling. If you leave this field blank, the system expects that a configuration exists with exactly
the same name as the site name, and it uses that as the target configuration.

The Reports To (entity) field on this tab is display-only. Reporting hierarchies are set up later
through the Change Reports to Entity utility. See Setting up the financial reporting hierarchy
on page 52.
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3 Review the list of linked sites shown in the Link Info tab.

If you used the Infor CloudSuite Business Configuration Wizard on the database server to set up
linked sites, this tab shows those links, which are used in transactional replication between the
currently selected site record’s database and other site databases.

See Linking databases on page 14.

• The local site’s record should show all the other databases linked to this site.

• The records for other sites should show the link to the local site.

• The Linked Server Name is the name of the database server where the site database resides.
• On the local site’s record, you can add any other needed links between this local site and other

site databases that will perform transactional replication with this database. If you later make
changes to this record, the changes can be replicated to other sites through manual replication
of the Site Admin replication category.

Regenerating views
Use the View Management form to regenerate table views.

1 At one site in each application database, open the View Management form.

2 Leave the range fields blank and click Generate.
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Regenerating triggers
Use the Trigger Management form to regenerate table triggers.

1 At one site in each application database, open the Trigger Management form.

2 Leave the range fields blank and click Generate.

Setting up replication categories and rules for transactional
replication
1 Familiarize yourself with the default categories listed in the Replication Categories form. Be aware

of what categories are available and what each one handles.

See the Multi-Site Planning Guide for additional information about the categories.

Use the default categories "as is" for now. You may want to add new categories later when your
system is up and running.

Adding new categories and rules requires significant knowledge of the database and business rules.
When multiple tables are related, the order of replication can be critical. Improperly creating and
executing replication categories and rules can result in catastrophic loss of data. Ensure that all
such development and testing is performed in a controlled pilot environment prior to implementation.
We strongly suggest that you contact Infor Consulting Services for assistance.

2 In the Replication Rules form, set up rules for the Site Admin category from this site to all other
sites where replication will take place.

• In the Interval Type field, select Transactional.
• You should have created a ReplicationRules spreadsheet as part of your planning phase. You

can save time by importing the appropriate rules for each site from the spreadsheet into the grid
on the form at that site.

See Data load to and from spreadsheets on page 95 for more information.

• If a rule refers to a site that is not set up with matching information in the Sites or Sites/Entities
form, a validation error is displayed when you try to save the rule.

• Even if a category contains _all tables that you plan to share, you generally should still include
replication rules for the category.
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The shared _all tables in the category will not be replicated; however, many categories contain
additional base tables or stored procedures that are needed to perform certain functions.

See the example in Setting up replication to sites in other intranets on page 37.

3 Go to the Replication Management form and click Regenerate Replication Triggers.

Note:  Finish this step for all sites before continuing with the next step.

If you have multiple sites or entities per database, you can set up rules for each site and entity and
then regenerate triggers for all sites and entities in the database from one site.

Populating parameter _all records at other sites
In the Update _All Tables form at each site, repopulate certain _all tables.

Note:  You must perform this step if the Sites or Sites/Entities form lists at least one site that is not
in the same application database, even if you are not currently replicating any data to/from that site.
The form lists only those tables that are shareable. If all of the internal sites (that is, sites on an intranet
that is not set to "External") which are listed on the Sites or Sites/Entities form reside in the same
application database, this should be an empty list.

In an initialized database, the parameters tables already have one record defined for the local site.
Because the record already exists, it will not be created at other sites through normal replication.
Repopulating the tables ensures that a parameter record for the local site exists at other sites where
it is needed.

Use these steps:

1 Click Deselect All to deselect all tables in the form.

2 Select the Initialize _All Parameters replication category and click Select By Category
to select the parameters tables.

3 Ensure that nothing else is selected, including Disable Replication or a site name.

4 Click Repopulate Tables to repopulate each selected parameters _all table at the local site and to
create or repopulate the local site record at any other sites to which the local site is replicating a
category that contains the parameter table.
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Backing up databases
At this point, back up all of your databases so that you do not have to re-add all of your replication
setup if problems occur later in the implementation.

Setting up a master site
Note:  Skip this section if you are not using a master site.

See the online help on the various forms for more information about any step.

Setting up all sites on the intranet
At all sites on the intranet where sharing will take place (including the master site), perform all the steps
to set up transactional replication. See Setting up transactional replication on page 30.

Note:  If you already have a shared master site and intranet, and you just want to add a new site to it,
seeAdding a site or entity to an existing shared tables intranet on page 101.

Then return to this section for additional instructions.

Setting up the master site
Log in to the site that you want to make the master site where the shared tables will exist for the intranet.
Then follow these steps at that site only:

Note:  Use a site, not an entity, as your master site.

1 Verify the information on the Link Info tab on the Sites or Sites/Entities form at the master site:

a On the Link Info tab for the master site’s record, each of the other sites on its intranet should
be listed as linked sites. For example, if the master site is ILL and the other sites on the intranet
are CRP, USA, and CAL, the local site record for ILL would list all the other sites on its intranet.

b On the Link Info tab for other site records on the shared intranet, the master site should be listed.

Infor CloudSuite Business Multi-Site Implementation Guide | 35

 

Setting up replication at sites



For example, when you are logged into the ILL master site, the CAL site record’s Link Info tab
would look like this:

Sites on other intranets do not require Live Link information at the master site.

2 On the Intranets form, select this site's intranet. In the Master Site field, specify the master site
where shared tables will reside.

These requirements must be met in order to add or change a value in this field:

• You must be logged into the site that you want to specify as the master site.
• This site must be defined as being within the selected intranet. Live links must be set up (on the

Sites or Sites/Entities form) between this site and the other sites in the intranet.
• No table within the intranet is currently shared using the Shared _All Tables utility.

This master site must be an CloudSuite Business site, not an entity.

Note:  After you define the master site for an intranet on the master site's Intranets form, the master
site name displays, but cannot be changed, on the Intranets form at all other sites. (This assumes you
have set up replication of the Site Admin category from the master site to the other sites in the intranet,
or the sites are in the same application database.)

Setting up shared _all tables
1 On the Intranet Shared Tables form at the master site, select this site's intranet. A list of the _all

tables that can be shared displays. (Not every _all table is listed; some are not available for sharing.)

Note:  If you share _all tables or user tables, all sites in the same database must be on the same
intranet.

Infor CloudSuite Business Multi-Site Implementation Guide | 36

 

Setting up replication at sites



2 For tables that you want to be shared between all sites on the intranet, select Shared.

Another way to choose the shared tables is to select the replication categories that you want to
share. When you select a replication category from the drop-down list and click Select by Category,
the system marks _all tables in that category as Shared.

3 When you have selected all the tables you want to share, select Actions > Save.

4 Click Process to copy information from the tables at the other sites to the master site's table, delete
the table from the other sites (creating views into the master site tables instead), and regenerate
the replication triggers for the other sites. If you have selected several tables and have many sites
on this intranet, processing may take a while. The Processing Step area displays the system's
progress.

Caution:  During processing, the selected tables are removed from all sites on the intranet except
the master site. Unsharing (rebuilding the tables at the using sites) is time-consuming - so be very
sure that you have everything set the way you want it before clicking the Process button.

During processing, the system validates live link setup between the master site and the using sites
of an intranet. If it finds a problem, an error message displays and nothing is processed; fix the link
and then click Process again.

The Processed field indicates which tables have been processed - for example, if shared, they are
now resident only in the master site's database. After a row on the form is marked as Processed,
subsequent "process" runs will not reprocess that row.

After processing all the tables and sites, the system regenerates the replication triggers at the master
site.

Setting up replication to sites in other intranets
If there are other intranets with sites that want to replicate (not share) _all table data to/from sites in
the sharing intranet:
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• For tables that are shared, set up replication categories/rules between the master site and the sites
on the other intranets. (You probably will also need to set up the same categories/rules between
the specific shared site and the sites on other intranets; see the example below.)

• For tables that are not shared, set up replication categories/rules between any/all of the sites in the
shared intranet and the sites on the other intranets.

Example

This flow chart describes four sites on two intranets:

• If CAL needs visibility into BC's item data, replication rules for a category containing the item_mst_all
table should be set up from BC to ILL.

• If BC needs visibility into CAL's item data, replication rules for a category containing the item_mst_all
table should be set up from ILL to BC.

• If BC and CAL interact in other ways, you must have additional replication rules between CAL and
BC, since additional tables and stored procedures are needed to perform these functions.

For example, if you have order entry of an item in BC and shipment of the item from CAL, you still
need Centralized Order Entry replication rules between CAL and BC, since additional tables and
stored procedures in that category are needed to perform these functions. The item_mst_all table,
although it exists in the category, will not be replicated from CAL to BC.

• If ONT needs visibility into CAL's customer data, which is not in a shared table, replication rules for
a category containing the customer_mst_all table should be set up from CAL to ONT.

Setting up non-transactional replication
Follow this section only if you are using non-transactional replication. See the definition of
non-transactional replication in Planning on page 12.

If you are using non-transactional replication only to interface to another Infor product, refer to the setup
steps in the appropriate product’s implementation guide, instead of the steps below.

Log into each site as the system administrator and perform these steps. See the online help on the
various forms for more information about any step.
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Setting up a replication user
Note:  Before you comple this step, you must install a license. See Setting up licensing at sites on
page 48 for instructions.

Create a user account that will be used during replication between the sites. Assign this user the
appropriate permissions to allow replication data to complete the transaction. This protects the local
site from another site inappropriately adding or modifying data on the local site without permission.

1 Add a replication user called repl_user on the Users form at all sites where non-transactional
replication will be used. Initially, make that user a super user and do not assign any authorization
groups.

The user must be assigned to a group, but it does not matter what multi-site group you assign this
user to.

If you have multiple administrators for different sites, you can later decide to revise the permissions
and groups assigned to this replication user, in order to limit the data that certain sites are allowed
to send to other sites. However, until everything is set up and working properly, leave this user as
a super user who can access everything.

2 Click User Modules and specify the license module to which this user is assigned.

Generally, you should assign the Automation license.

Setting up system types
If this site will be replicating data to other applications, or to other versions of Infor CloudSuite Business,
use the System Types form to create a system type for each other application/version. This system
type is used when defining the target site for the application in the Sites or Sites/Entities form. You
should also define a system type for the CloudSuite Business application. (The source and target
system types are used in the names of XSL stylesheets that can be used to transform the XML data;
see the System Types help topic for more information.)

The list of system types should match at all sites. System Types are replicated by the Site Admin
category rules, so create a minimum list now and add more types later as needed.
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If there is not an existing system type called CloudSuite Business, add it. Some add-on applications
might require this system type.

Defining intranets for use with non-transactional replication
1 In theIntranets form, specify all intranets to be used in this multi-site system. The default intranet

is DEMO. During the planning phase you should have determined whether you need additional
intranets, and which sites will use them.

Some forms, like this one, open “filter-in-place,” where all of the fields on the form are blank. You
can then specify filter criteria in one or more fields to retrieve a collection of records that meet those
criteria. Alternatively, you can leave all fields blank and click the filter button in the toolbar to see all
existing records and add new ones.

2 Specify connection information used in data requests to and from the other sites:

External
Select this field if the intranet is an external intranet, meaning that it allows applications other than
those based on the CloudSuite Business (WinStudio) toolset. Replication done on an external
intranet must be non-transactional, and an external intranet cannot have a master site.

Transport
This field, which is enabled if you selected External, allows you to select either HTTP or ESB as
the transport protocol for exchanging data with external applications:
• HTTP is used to handle most non-transactional replication. If you select HTTP, you then define

a set of MSMQ instances, MSMQ listeners, and URLs for the intranet.
• ESB is used to connect to messaging middleware through Infor ION.

Master Site
See Setting up the master site on page 35.

Tenant ID
This field is used during integration to other applications through business object documents (BODs).
See the online help for more information.

3 If you selected HTTP as the transport method, these additional options are enabled:

Queue Server
Enter the name of the MSMQ server for the intranet. If left blank, this field defaults to the utility
server running this application, and the private queue area. If you have multiple intranets on different
servers, include the utility server machine name in the path (for example, machinename\PRIVATE$).

Private Queue
We recommend that you select this field, since queues in non-transactional replication are used
only by CloudSuite Business services on the same machine. Setting up public MSMQ instances
requires further ActiveDirectory setup, which is not required by the CloudSuite Business services.

URL
This is the web address to which the XML request/response documents will be posted. When
replication occurs between sites on different intranets, XML documents are routed to this URL for
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the target site. It may also be used by system integrators for programmatic access to a site on this
intranet.

This URL could be an active server page (ASP) on the external system that receives and processes
the XML from the CloudSuite Business message queue. The processing done at this URL is up to
you; for example, an ASP could map the data into the proper format for the external system, or it
could write the XML documents to a location on its server for later processing.

In many cases, this field provides the address of the default InboundQueue ASP in the virtual
directory that was installed with the web server components.

Direct IDO URL
This is the web address of the synchronous XML interface to this Intranet. It is used primarily by
WinStudio clients which are configured to connect via the Internet. It may also be used by system
integrators for programmatic access to a site on this intranet.

You must specify a fully qualified URL. It should be the address of the ConfigServer, which is
deployed on your utility server when you include the web server feature of the utility server setup.
For example, if the machine name is UTILSERVER, then the URL might look like this:

http://UTILSERVER/IDORequestService/ConfigServer.aspx

If you want to use secured http, which is a good idea if this server will be open to the internet for
http traffic, use this format:

https://UTILSERVER/IDORequestService/ConfigServer.aspx

4 In the TaskMan Path field for each intranet, specify the shared path to the folder containing
TaskMan.exe on the utility server used by that intranet.

This path is usually set to \\servername\SyteLine.

For more information about how this field is used, see the Multi-Site Planning Guide information on
TaskMan monitoring.

Whenever you change the TaskMan Path, you should restart all TaskMan services that monitor
configurations for application databases connected to this intranet.

Defining linking between sites for non-transactional
replication
Use the Sites or Sites/Entities form to define sites in your system.

1 On the Sites or Sites/Entities form, in all records for sites that will be participating in non-transactional
replication, specify a System Type in the System Info tab.

The list of types that is displayed here was created in the System Types form. The system type
you choose should exist at all of your sites.

If this is a new site record being added for non-transactional replication, specify additional information
about the site, as applicable, on this tab.
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2 In the Configuration Name field, specify the name of a configuration that the system will use as
the target configuration when building IDORequest XMLs during replication and AES event handling.
If you leave this field blank, the system expects that a configuration exists with exactly the same
name as the site name, and it uses that as the target configuration.

Note:  The Reports To (entity) field on this form is display-only. Reporting hierarchies are set up
later through the Change Reports to Entity utility.

3 On the Site User Map tab, specify the CloudSuite Business user name under which the local site,
that is, the site where you are currently logged in, communicates with the target site, that is, the site
whose record is currently displayed.

From Site is the local site. User Name is the local user that the local site specifies when using the
IDO connection to perform the requested transaction on the target site. The user name and the
password for that user must be the same on both the local and target sites.

For now, specify the user name repl_user for all sites. See Setting up a replication user on page
39.

• For site/entity records where the current site/entity will perform non-transactional replication with
the local site, the Site User Map tab looks like this:

BC (the current record) is the "To" site and ILL (the local site) is the "From" site.

• For site/entity records where the current site/entity will perform transactional replication with the
local site, the Site User Map tab looks like this: The tab is blank because no Site User information
is required from ILL to CAL.
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• If you are upgrading from a previous version and choose to continue to use the “bootstrap” site
method, instead of the preferred “list of configurations” method:
• For the local site’s site/entity record when the local site is also used as the replication

"bootstrap" configuration for the utility server, the Site User Map tab looks like this: The Site
User Map lists all the other sites on the utility server where replication will be "bootstrapped"
from ILL (the local site).

For the local site’s site/entity record when the local site is not used as the "bootstrap"
configuration, the Site User Map tab looks like this: No sites are listed in the Site User Map
tab (because the CAL site does not replicate data to itself).
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Example: Using a list of configurations
If you use the preferred “list of configurations” method, where the system uses information from the
database into which users are logged, ensure that the local site has Site User Map rows associated
with each of the “From Sites” from which the local site will receive non-transactional data. This scenario
is illustrated by this example:

You have three databases:

• DB1 has one site, Shanghai.
• DB2 has one site: Windsor.
• DB3 has two sites, CMH and CIN.

Communication between the sites is set up like this:

• CMH and CIN communicate through synchronous (transactional) replication with each other.
• CMH and CIN communicate through asynchronous (non-transactional) replication with Shanghai

and Windsor.
• Shanghai and Windsor communicate through asynchronous (non-transactional) replication with

CMH and CIN and with each other.

Each database contains five site records:

• Shanghai
• Windsor
• CMH
• CIN
• INFORBUS (used for communications with ION)

The Sites or Sites/Entities form includes these Site User Map rows for each database:

Contains these Site User Map rowsDB1 site record

From Site: Windsor

From Site: CMH

From Site: CIN

Shanghai

Windsor

CMH

CIN

From Site: Shanghai

From Site: Windsor

From Site: CMH

From Site: CIN

INFORBUS

Contains these Site User Map rowsDB2 site record

Shanghai
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Contains these Site User Map rowsDB2 site record

From Site: Shanghai

From Site: CMH

From Site: CIN

Windsor

CMH

CIN

From Site: Shanghai

From Site: Windsor

From Site: CMH

From Site: CIN

INFORBUS

Contains these Site User Map rowsDB3 site record

Shanghai

Windsor

From Site: Shanghai

From Site: Windsor

CMH

From Site: Shanghai

From Site: Windsor

CIN

From Site: Shanghai

From Site: Windsor

From Site: CMH

From Site: CIN

INFORBUS

Regenerating views
Use the View Management form to regenerate table views.

1 At one site in each application database, open the View Management form.

2 Leave the range fields blank and click Generate.

Regenerating triggers
Use the Trigger Management form to regenerate table triggers.

1 At one site in each application database, open the Trigger Management form.

2 Leave the range fields blank and click Generate.
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Setting up replication categories and rules for
non-transactional replication
1 Familiarize yourself with the default categories listed in the Replication Categories form. Be aware

of what categories are available and what each one handles.

See the Multi-Site Planning Guide for additional information about the categories.

Use the default categories "as is" for now. You may want to add new categories later when your
system is up and running.

Adding new categories and rules requires significant knowledge of the database and business rules.
When multiple tables are related, the order of replication can be critical. Improperly creating and
executing replication categories and rules can result in catastrophic loss of data. Ensure that all
such development and testing is performed in a controlled pilot environment prior to implementation.
We strongly suggest that you contact Infor Consulting Services for assistance.

2 In the Replication Rules form at each site, set up non-transactional rules for the Site Admin
category between this site and all other sites where non-transactional replication will take place.

Add more non-transactional rules from this site to other sites, as appropriate.

• In the Interval Type field, select anything other than Transactional.
• You should have created a ReplicationRules spreadsheet as part of your planning phase. You

can save time by importing the appropriate rules for each site from the spreadsheet into the grid
on the form at that site.

See Data load to and from spreadsheets on page 95 for more information.

• If a rule refers to a site that is not set up with matching information in the Sites or Sites/Entities
form, a validation error is displayed when you try to save the rule.

3 At each site, open the Replication Management form and click Regenerate Replication Triggers.

Note:  Finish this step for all sites before continuing with the next step.

If you have multiple sites per database, you can set up rules and regenerate triggers for all sites in the
database from one site.

Populating parameter _all records at other sites
In the Update _All Tables form at each site, repopulate certain _all tables.
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Note:  You must perform this step if the Sites or Sites/Entities form lists at least one site that is not
in the same application database, even if you are not currently replicating any data to/from that site.
The form lists only those tables that are shareable. If all of the internal sites (that is, sites on an intranet
that is not set to "External") which are listed on the Sites or Sites/Entities form reside in the same
application database, this should be an empty list.

In an initialized database, the parameters tables already have one record defined for the local site.
Because the record already exists, it will not be created at other sites through normal replication.
Repopulating the tables ensures that a parameter record for the local site exists at other sites where
it is needed.

Use these steps:

1 Click Deselect All to deselect all tables in the form.

2 Select the Initialize _All Parameters replication category and click Select By Category
to select the parameters tables.

3 Ensure that nothing else is selected, including Disable Replication or a site name.

4 Click Repopulate Tables to repopulate each selected parameters _all table at the local site and to
create or repopulate the local site record at any other sites to which the local site is replicating a
category that contains the parameter table.

Backing up databases
At this point, back up all of your databases so that you do not have to re-add all of your replication
setup if problems occur later in the implementation.
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Chapter 6: Setting up licensing at sites

You must have requested and received the proper licenses for each of your sites from your Infor
representative. Use the Licensing spreadsheet from your planning phase to help with this.

Intranet licensing
If you do not plan to use intranet licensing, skip toSite licensing on page 49 .

Note:  Intranet licensing is required if you plan to use the Intranet Shared User Tables feature.

Prerequisites
If you plan to use the Intranet Licensing feature, these requirements must be met. Instructions for all
of these prerequisites are found in Setting up replication at sites on page 30

• You must have set up an intranet with a master site.
• All sites that will use the intranet licensing must be set up (in the Sites or Sites/Entities form) to

use that intranet.
• All sites on that intranet must be replicating the Site Admin category, in order to recognize the master

site.
• All sites that will use the intranet licensing must specify an application database name in their Sites

or Sites/Entities form.

Activating intranet licensing at the master site
1 At the master site only, log in and follow the steps in Site licensing on page 49 to apply a license.

2 In the master site’s Sites or Sites/Entities form, select the Intranet Licensing check box on the
local site record and save the record.
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Activating intranet licensing at other sites
1 Ensure that all other users are logged out of the sites.

2 Log into any other sites where you want to use the master site’s licensing.

3 On the Sites or Sites/Entities form at each site, select the local site record and select Intranet
Licensing. Save your change.

4 Log out of all the sites, including the master site, and then log back in. This picks up the changes
to certain licensing records, which are now stored only on the master site. The licensing forms are
now disabled in the non-master sites on the intranet.

Site licensing
Note:  Licensing is applied to an application database.

If you have multiple sites in one application database, you apply licensing in one site in the database,
and then use the Optional Modules form in each of the sites in the database to enable the features
for licensed modules in that site.

Setting up site licensing
1 Perform these steps at each site. Alternatively, if you are using intranet licensing, perform these

steps only at the master site.

a In the License Management form, select the Apply License tab.
b Paste your license document into the License Document field. You can cut and paste the

information from the license document into this field, or you can click Browse and select the
document from your drive. The document is encrypted and every character counts, so if you
copy and paste, ensure that you copy the entire contents of the document.

c Click Apply License.

Any previous licensing that you had for this site is deleted and replaced with the licensing defined
in the new license document.

The Licensed Modules tab should show information about your licensed modules after you
apply your license.

The Multi-Session Users tab lists any multi-session users defined by your license; generally
this just displays the SL_Internal user.

For information about this user and about how concurrent or named user licensing works, see
the Infor CloudSuite Business Licensing Administration Guide.

2 At each site, use the Optional Modules form to enable the licensed modules for that site.

3 If there were active WinStudio sessions when you applied the license, perform these steps on the
utility server. If there were not any active sessions, you can skip these steps.

a To open the Configuration Manager utility, select Start > All Programs > Infor > Tools >
Configuration Manager.
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b Select the Utilities tab.

c Discard the Runtime Service Cache for all configurations that reference the application database
to which the new license has just been applied. To do this, select All Configurations and IDO
Runtime on local machine, and then click Discard IDO Cache.

See the Configuration Manager online help for more information about the options on this tab.

Viewing sites where users are connected
The License Modules per User Connection form has a Sites column that lets you monitor the site
to which each user is connected.
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If Intranet Licensing is enabled, this form shows the site from which the users are connected. In
non-intranet licensed environments, only connections from the current site are shown.
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Chapter 7: Setting up accounts and financial reporting
hierarchies

Follow these steps to set up financial accounts and hierarchies.

Setting up the financial reporting hierarchy
Perform this step only if you are setting up a hierarchy of sites and entities.

1 At each site and lower-level entity, run the Change Reports To Entity utility and specify the entity
to which this site or entity reports.

• Use your flowchart from the Multi-Site Planning Guide to help you set up this hierarchy.
• If there is only one entity in the hierarchy, you do not need to run this utility at the entity.
• You do not need to run this utility at the highest-level entity in the hierarchy.
• For sites and entities that will communicate financial information through replication, replication

rules must be set up and running before you run the Change Reports To Entity utility. The Change
Reports To data is replicated in the G/L or Ledger Consolidation categories, and the Reports
To field is replicated in the Site Admin category.

• Before you run this utility, ensure that the base currency and the chart of accounts match at the
current site and at the entity it will report to. (If this is a new site or entity, the chart of accounts
does not yet exist.)
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• The site will report to the new entity on the day after the Cutoff Date. This date cannot be earlier
than the creation date of the site database.

• During consolidation, the system looks for a currency exchange rate with the Currency
Translation Date that you specify on this form, and then uses that rate for the consolidation.

• See the online help for additional information about this utility.

2 After you run this utility, verify whether the reporting hierarchy is set up correctly. Go to the
Sites/Entities form at the highest-level entity and check whether the Reports To field displays as
expected for each site and entity.

Setting up accounts
1 In the Chart of Accounts form at the corporate (highest-level) entity, add all of your accounts. If

your system does not include any entities, set up the Chart of Accounts at each site.

You might be able to input your accounts from a spreadsheet that is set up to match the form’s grid
view. See Data load to and from spreadsheets on page 95.

You cannot add the unit code information in the same spreadsheet as the account information, since
they are different collections.

a If you have entities and are consolidating accounts, be sure to add an account with an Account
Type of Owner’s Equity to be used as your Cumulative Translation Adjustment (CTA) account.

b Make sure that Inter-entity account numbers used for material transfers at sites that perform
transfers with profit are different from your normal sales account numbers. This helps you know
what to eliminate as profit when you consolidate to the entity level.

c By default all unit codes are accessible for all accounts. If you want certain unit codes to be
required or not accessible for certain accounts, specify that in the Chart of Accounts at the
corporate entity. When you save the account record, this message is displayed for each unit
code that you marked as not accessible: Any Unit Code x values for this Account
will be deleted.
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d Click OK.
e Do not set up information on the Unit Code 1-4 tabs yet. This information may be different for

each account at each site/entity and will be set up later, after unit codes are defined.

2 If you have multiple levels of entities, perform these tasks. If you have only one entity, or no entities,
skip these tasks.

a At the corporate entity, use the Multi-Site Chart Copy formto copy the chart of accounts from
the corporate entity to any mid-level entities that use the same (or similar) chart of accounts.

You might see the message Account will be created. If so, click OK. When processing
is complete, a message indicates the number of accounts that were processed.

If an error message displays while you are performing this step, see the information in
Troubleshooting on page 80.

If a different chart of accounts is required at the mid-level entity, then the chart of accounts can
be created at the mid-level entity, setting up Reports To accounts to the corporate entity.

b In mid-level entities, use the Chart of Accounts form to map each account to a "Reports To"
account in the entity being reported to. You must do this in order for the Ledger Consolidation
utility to work properly.

• The existing accounts at the higher entity are listed in the Reports To Acct field drop-down.
You can map to the same account or to a different account.

• If the mid-level entity’s base currency is different from the higher entity’s base currency, you
can specify the currency translation method to use when consolidating the account information.
To comply with FASB52 or GAAP standards, you must set the currency translation method
to Average for revenue and expense accounts and to End for asset and liability accounts.

3 Verify that the Chart of Accounts was automatically populated in each of the sites reporting to
each entity. This is handled by ChartAcctRemoteSp in the Ledger Consolidation or G/L replication
category.

Users cannot change the chart at the child sites, but they can update descriptions, delete accounts
that do not apply to the local database, update obsolete/effective dates, and set up the Unit Code
1-4 tabs for the accounts.

4 At each site and entity, set up the unit codes that can be selected for each account.

Infor CloudSuite Business Multi-Site Implementation Guide | 54

 

Setting up accounts and financial reporting hierarchies



a Define unit codes on the Unit Code 1-4 forms. See the help topic on "Account Unit Code (1-4)"
for information about how unit codes are used.

You might be able to input your unit codes from a spreadsheet that is set up to match the form’s
grid view. See Data load to and from spreadsheets on page 95 for more information.

b Run the Copy Unit Codes to Accounts form to copy a range of unit codes to a range of accounts.
This fills in the information for each account on the Chart of Accounts form’s Unit Codes tabs
at the site or entity. If an account is set up so that one or more of the unit codes is inaccessible,
the utility does not populate those unit codes.

Run the Copy Unit Codes to Accounts form to copy a range of unit codes to a range of accounts.
This fills in the information for each account on the Chart of Accounts form’s Unit Codes tabs
at the site or entity. If an account is set up so that one or more of the unit codes is inaccessible,
the utility does not populate those unit codes.

c For greater efficiency, you can copy all unit codes to all accounts in step b, and then go to the
Chart of Accounts form to delete individual unit codes from certain accounts, as appropriate.

5 At all entities, in the Accounting Periods form, add accounting periods. If your system does not
include any entities, set up Accounting Periods at each site.
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Accounting periods that are set at an entity automatically populate each child site’s accounting
periods (through Ledger Consolidation or G/L replication). If you have entities, you cannot update
accounting periods at the site level. You will maintain the Current Period at all entities and sites.

Accounting periods must be set up manually at mid-level entities. You might want to export the
accounting period grid at the corporate entity to a spreadsheet, to use when populating mid-level
entities. See Data load to and from spreadsheets on page 95 for more information.

6 Make sure the Accounting Periods were replicated to the appropriate sites.

7 If you have multiple levels of entities, do this: at mid-level entities, run the Verify Reports To Account
Report, clearing the Invalid Accounts Only flag so that all accounts are listed. Keep this report
for future reference. If you have only one entity, or no entities, skip this step.

Multiple financial sets of books
If you need more than one set of financial books, you can set up that feature at any time, for a specific
site. The first step is to select Multiple Financial Sets of Books on the General Parameters form.
See Setting general parameters on page 60.

For more information, see the help topic on setting up multiple financial sets of books.

Setting up financial statements
During the planning phase, you should have determined where you want to run financial statements
(at which level of entity, or at each site). Perform this step at those sites or entities.

Use the Financial Statement Definition form, along with the Financial Statement Definition Columns
and Financial Statement Line Definition forms, to specify the content and format of a statement.

After you define a statement, you can print it by specifying the Report ID in the Financial Statement
Output form.

These are some reports that you might design with the Financial Statement Definition form:

• Balance Sheet
• Income Statement (Profit and Loss)
• Statement of Cash Flow
• Components of Working Capital
• Changes in Financial Position

See the online help topic about financial statement setup for the steps to follow.

You can also use CloudSuite Business’s Excel-based toolset for financial reporting to connect to any
site or entity database and extract data, using formulas, into a spreadsheet. The spreadsheet can then
be used for financial reporting. The toolset supports multi-currency consolidation with its currency
conversion feature. For more information, see the Infor CloudSuite Business Microsoft Office Integration
User Guide.
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Chapter 8: Setting up parameters and codes

Parameters and codes must be set up at this point, because they are used when you create the records
in later steps. Any special implications for multi-site setup are explained in this section. Read the online
help for each form to get additional details.

Note:  Many parameters and codes do not need to be set up at sites that are defined as financial
entities. This section specifies which parameters and codes are to be set at entities.

Setting up site groups
At all sites and entities, set up Site Groups for the various sites that will be doing centralized order
entry, transfer orders, or financial reporting.

Since Site Groups are replicated (in the Site Admin category), they can be set in one site or entity and
be replicated to other linked sites/entities.

One site group was set up with the Infor CloudSuite Business Configuration Wizard on the database
server, but the sites in the group might need tweaking, or you might want to define additional groups
for additional purposes.

Setting up countries and states
1 For each site and entity, go to the Countries form and add records for the countries listed on the

Currency spreadsheet you created during the planning phase. Include any countries that are needed
for the site or entity addresses on the General Parameters form. See Setting general parameters
on page 60. You can also add other countries needed for customers and vendors.
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• Country codes are replicated to other sites/entities if A/P, Shared Currency, or Centralized Order
Entry categories are being replicated. Thus, if you are maintaining currency information at one
site or entity and replicating it to the others, you should enter your initial country list at the site/entity
where you will maintain currency information.

• If the Activate EU VAT Reporting field is not selected on the General Parameters form, the
EU and SSD EU fields are disabled here and do not allow data entry.

• When you integrate CloudSuite Business with other Infor BOD-enabled products, only ISO country
codes can be passed in the BODs. If you are creating a new system, we recommend that you
use the ISO country codes when defining new countries. If you already have existing non-ISO
country codes, you can map them to ISO codes using this form.

2 For each site and entity, use the Prov/States form to create province and state records to be used
when you specify the company address in the General Parameters form for each site and entity
database. You can also add other provinces and states needed for customers and vendors.

Province and state codes are replicated in the Multi-Site CRM category.

Setting up currency
1 For each site and entity, set up Multi-Currency Parameters. These are used as the default account

values when you add new currency codes.
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• Domestic currency was determined when the database was created and cannot be changed.
• Use the Allow Currency Rate Override field to determine whether a currency exchange rate

can be overridden. If you select this check box, the exchange rate can be overridden on transaction
forms. You can also specify the override tolerance type and amount to be used. You can clear
the setting for a selected currency code on the Currency Codes form. However, if you clear the
Allow Currency Rate Override option on the Multi-Currency Parameters form, then even if
the setting is selected on the Currency Codes form for a specific currency, overrides are not
allowed.

• You can return to this form later to specify the Euro currency, if necessary. It is not defined until
the next step.

• This information is not replicated and must be entered at each site and entity.

2 For each site and entity, set up information on the Currency Codes form.

When you use this form, a message is displayed to indicate that you must log out of CloudSuite
Business after you update this information. However, you actually can continue through setting up
the General Parameters before logging out and restarting CloudSuite Business.
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• Some currency information is replicated to other sites/entities if categories containing the
currency_mst, currency_mst_all, currate_mst or currate_mst_all tables are being replicated. So
if you are maintaining currency information at one site or entity and replicating it to the others,
you should enter your initial currency codes at the site/entity where you will maintain currency
information. You can also specify the override tolerance type and amount to be used.

• When you integrate CloudSuite Business with other Infor BOD-enabled products, only ISO
currency codes can be passed in the BODs. If you are creating a new system, we recommend
that you use the ISO currency codes when defining new currencies. If you already have existing
non-ISO currency codes, you can map them to ISO codes using this form.

• The currency codes, formats, and rates are replicated with any category that contains the tables
listed above, but the related account information is not replicated.

• Use the Currency spreadsheet you created during the Planning phase. An initial record already
exists for the site’s domestic currency, so do not include the domestic currency in the import from
the spreadsheet. Edit that record manually in the form.

3 If you set up additional currencies beyond the domestic currency, then when you save the record
the system asks if you want to run the Currency Rates form to create rates for the new currency
codes. Click No.

(Clicking Yes opens the Currency Rates form linked to the last new currency you added. It is faster
to set multiple rates using an unlinked version of the form, as in step 4.)

4 For each site and entity, on the Currency Rates form, specify the appropriate rates between the
domestic currency and any other currencies. Rates can be modified later.

Setting general parameters
Note:  Some general parameter information for each site can be replicated to other sites and stored
in the parms_mst_all table. None of that information from other sites is displayed on the General
Parameters form, however.

1 For each site and entity, go to the General Parameters form.

2 On the Address tab, specify the company address to be used for the entity or site. The name and
address specified on this tab is displayed on invoices, checks, credit/debit memos, payroll and tax
documents, and so on.

3 On the General tab, specify at least these options. Many of these parameters enable or disable
other features and fields in CloudSuite Business. Use the online help to select the options you need.
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• Update the Current Fiscal Year.
• Specify a multi-site group. This group becomes the default value that is used in the Site Group

field on reports and utilities.
• Optionally, specify a transfer/project BOL prefix. Site-specific prefixes can make it easier to

determine which site originated an advance ship notice.
• Select Set Default Ending Value to Starting Value. Then, in any form where users can specify a

range of values, the value they specify in the Starting field is automatically set as the default
value in the Ending field. This prevents users from accidentally running extremely long reports
that list all possible values.

• If you want to use multiple financial sets of books, select that option. For more information about
this feature, see the online help.

• For entities, specify the CTA Account. This account is used to store the currency translation
differences that might occur during the consolidation of accounts to this corporate entity.

Note:  The CTA account can only be set up after the Reports To Entity hierarchy is set up. See
Setting up the financial reporting hierarchy on page 52.

4 Log out of the site and then log back in. Changes to the currency codes and the general parameters
require this.

Setting up bank codes
At each site, you must set up at least one bank code. If A/P checks will be written in multiple currencies,
you must set up a bank code representing each currency. Use the Bank Reconciliations form to do
this.
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Setting system parameters
1 At all sites that will transfer items or material to other sites, use theInter-Site Parameters form to

establish the relationship between sites and to identify the inter-company account numbers to use
during transactions. See the help topic about moving items or materials between sites.

• This form must be completed before any multi-site activities take place. Specify the information
in one site, and then most of the information in the records is added automatically at other sites
where Site Admin is being replicated.

• On the General tab, specify this information:
• Posting Method: Although your choice here is "intra-entity" or "inter-entity," this setting really

has little to do with entities. It determines how accounting transactions between the sites are
handled. Think of "intra-entity" as "at cost" and "inter-entity" as "with revenue."

• Price Code: This code can be selected here but it is not defined yet. Return to this form and
select a price code later. The price code is only used when the Posting Method is inter-entity.

• Exchange Rate: The exchange rate is only used when the To Site and the From Site have
different base currencies.

• If the Posting Method is intra-entity, specify accounts in the fields listed at the bottom of this
tab.

• The information on the Ship From, Ship From COS, and Receive To tabs is used only when
the Posting Method is inter-entity.

• The information on the Payment tab is used only for A/P and A/R payments.

2 At the sites, set up Accounts Receivable Parameters:

• You must specify a multi-site group on this form. Only records for sites in this group are considered
when performing Accounts Receivable payments and quick invoice payments, and when
consolidating A/R posted transactions.

• You can set up a customer prefix that indicates the originating site as well as the type of record.
For example, you can use CI as the prefix for customer numbers local to the ILL site and CC for
customers local to the CAL site. If you have global customers, you could have one site that can
create only global customers, and use the prefix CG in that site. For more information about
prefixes, see the Infor CloudSuite Business Multi-Site Planning Guide.

• A credit hold reason code can be specified here but is not defined yet. You can return to this
form later to select the appropriate code.
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3 At the sites, set up Accounts Payable Parameters:

• You must specify a multi-site group on this form. Only records for sites in this group are considered
when performing Accounts Payable payments and quick voucher payments, and when
consolidating A/P posted transactions.

• You can set up a vendor prefix that indicates the originating site as well as the type of record.
For example, you could use the prefix VI for vendors local to the ILL site and VC for vendors
local to the CAL site. If you have global vendors, you could set up one site that can create only
global vendors, and use the prefix VG in that site. See the Infor CloudSuite Business Multi-Site
Planning Guide for more information about using prefixes.

4 At the sites, set up Order Entry Parameters:

• Specify the invoice number length in the Invoice Length field. We recommend that you set this
field to 12, which is the maximum.

Caution:  The invoice number length must be the same for all sites in the system. It must be
set at each site; it cannot be replicated to the other sites. When you enter a value here, the
system verifies it against the Invoice Length value set for other sites, if the other sites are
replicating at least one category containing the coparms_all table with this site. After the Invoice
Length field is set to a non-null value, the value can never be updated. When you save the
change, the system updates about 50 database tables, so it may take a long time to process.

• If you plan to use delivery orders, specify the DO/BOL length.
• Site-specific prefixes are recommended if Centralized Order Entry, Invoice Builder, or Accounts

Receivable payments across sites will be performed. See the information on prefixes in the Infor
CloudSuite Business Multi-Site Planning Guide.

• If you will use DIFOT (Delivered In Full and On Time) as a standard to measure delivery
performance in your supply chain, provide tolerances in the DIFOT tab.

• If the Price From Originating Site field is selected, default item prices for CO lines are pulled
from the site originating the order. This allows you to maintain pricing in one centralized site.
Otherwise, the system pulls the default prices from the site that ships the order line item.

Caution:  After you update the Invoice Length and/or DO/BOL Length and save the record,
log yourself and all other users out of CloudSuite Business. This resets the session variables.
Then use the Configuration Manager utility (on the utility server) to publish form changes. This
clears the form cache on your users’ computers the next time the users log in to CloudSuite
Business.

• When you save this record, you might see a message that asks you to perform manual replication
of A/R data. If so, go to the Manual Replication Utility, select the A/R category, and select the
site(s) to which A/R data is being replicated. This ensures that the required data is in the proper
tables at the other sites.

5 At the sites, set up Purchasing Parameters.

Site-specific prefixes are recommended if Accounts Payable payments across sites will be performed.
See the information about prefixes in the Infor CloudSuite Business Multi-Site Planning Guide.

6 At the sites, set up Transfer Order Parameters.

Site-specific prefixes are recommended to make it easier to determine which site initiates a transfer
order. See the information about prefixes in the Infor CloudSuite Business Multi-Site Planning Guide.

7 At the sites, if you will use MRP or APS, set up the information in the Planning Parameters form.
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See the online help and the Infor CloudSuite Business APS Configuration Guide for information
about how to set up these parameters for use in a multi-site environment.

8 At the sites, set up Inventory Parameters to determine how CloudSuite Business handles inventory
at each site.

You can choose to track the cost of items at the warehouse level rather than at the item level (that
is, for the entire site). See the help to determine the consequences of this selection.

9 At the sites, go to the Master Explorer > Modules > Codes > Parameters and open the other
parameters forms that you have not yet accessed, to set up parameters appropriate for your system.

• Depending on your system, you might not need to set up some of these parameters.
• Some forms might require selection of data that is not yet set up. If so, return to finish the setup

of those forms later.
• When a prefix field appears on a parameter form, you might want to specify a site-specific prefix

where appropriate, as described for the other parameter forms above.

10 After you update all parameters, log out of each site or entity and then log in again. This updates
system variables so that they contain the latest parameter information.
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Chapter 9: Setting up users and authorizations

If you plan to use a master site to maintain users for all sites on an intranet, set up the shared user
tables as described below and then perform the other steps in this chapter only at the master site.

If you plan to use a master site and you are using Intranet Licensing, the users at all sites must also
be defined at the master site. Then the users must be assigned to license modules on the master site
through the User Modules form.

If you are not using a master site, skip the first step and perform the other steps in this chapter at each
site to set up users.

Setting up shared user tables
Note:  If multiple sites that belong to the same intranet are not in the same application database, then
Intranet Licensing must be set up at the master site and all participating sites before you can share
user tables for the sites. This requirement does not apply when the sites are in a single database.

You can maintain user and group names and permissions, user-group mappings, user license module
assignments, and application-specific user information at the master site of an intranet. To do this, you
must share the user tables from all sites on the intranet; that is, set up views to the tables, which only
reside at the master site:

1 Log in to the master site for the intranet where you want to share user tables.

2 On the Intranet Shared User Tables form, select the master site's intranet.
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Two lists of tables are displayed:

• The top grid lists user tables that can be shared. You can clear the Shared option for some tables,
but not all of them, as described below.

• The bottom grid lists tables that contain a column whose base domain is UserNames.UserId or
GroupNames.GroupId. The bottom grid is used during setup of shared user tables to identify the
tables and columns that may need to be updated if records that were formerly defined in the
Usernames or Groupnames tables in the non-master site are moved to the master site, but with
different UserId or GroupId values.

3 If you have custom tables that contain a column whose value comes from base domain
UserNames.UserId or GroupNames.GroupId, add your custom table and its associated ID column
to the Non-Shareable Tables grid. We recommend that your custom tables refer to the Username
or Groupname columns, rather than the ID columns, because the distinct list of Usernames and
Groupnames across intranet sites is always the same, whether they are stored in shared tables or
per site, and therefore no changes are required for data referencing this base domain.

4 Select Set up shared user tables, which automatically selects Shared for all tables in the top grid
and Update Referenced ID for all tables in the bottom grid.

5 In the top grid, clear the Shared check box for any tables that you do not want to share between
sites.

Be aware of how this option works:

Result for multiple sites per
database

Result for one site
per database

Select Shared
on Intranet
Shared User
Tables?

Table names

Tables are shared for multiple
sites within a database, but
not across different databases.

Tables are not
shared across multi-
ple sites.

NoUsernames, GroupNames,
UserEmail, UserModules,
UserPasswordHistory,
UserCalendar, and User-
Task
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Result for multiple sites per
database

Result for one site
per database

Select Shared
on Intranet
Shared User
Tables?

Table names

Tables are shared across
multiple sites and databases.

Tables are shared
across multiple
sites.

YesUsernames, GroupNames,
UserEmail, UserModules,
UserPasswordHistory,
UserCalendar, and User-
Task

Tables are not shared across
multiple sites.

Tables are not
shared across multi-
ple sites.

NoAccountAuthorizations_mst,
user_local_mst, and User-
GroupMap_mst

Tables are shared across
multiple sites and databases.

Tables are shared
across multiple sites
and databases.

Yes. You can
select each of
these tables indi-
vidually for shar-
ing.

AccountAuthorizations_mst,
user_local_mst, and User-
GroupMap_mst

6 Click Process to copy information from the tables at the other sites to the master site's table, delete
the table from the other sites (creating views into the master site tables instead), and regenerate
the replication triggers for the other sites. (Removing tables and setting up views does not happen
if the non-master site is in the same application database as the master site.)

If you have many sites on this intranet or many users and groups, processing can take a while to
complete. The Processing Step area displays the system's progress.

During processing, the system validates link setup between the master site and the using sites of
an intranet. If it finds a problem, an error message displays and nothing is processed; fix the link
and then click Process again.

The Processed field indicates which tables have been processed - for example, if shared, they are
now resident only in the master site's database. (After a row on the form is marked as Processed,
subsequent "Process" runs do not reprocess that row.)

The Status field indicates that the user tables are either shared or not shared.

After processing all the tables and sites, the system regenerates the replication triggers at the master
site.

7 After processing is complete, you must reapply a valid license document on the master site.

8 In the master site, open the View Management form and regenerate views at the master site, so
that the views reflect the changes to table sharing.

9 In the master site, open the Trigger Management form and regenerate table triggers at the master
site.

The SL_Internal user exists in every site. It is a multi-session internal user. You should not have to
modify any information about this user.
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Setting up password parameters
Use the Password Parameters form to specify password expiration and complexity rules for all users.
Be sure to explain the rules you choose to the users of your system.

The password parameter data is replicated as part of the Site Admin category.

Adding common users
Note:  In an environment where CloudSuite Business in running in Infor Ming.le, you add users in Infor
Ming.le as described in the Infor CloudSuite Business Configuration Guide. The user definitions are
sent through BODs to CloudSuite Business. Use the information in this chapter to complete the setup
for each user in CloudSuite Business.

1 In the Users form, set up other common users who will be working in multiple sites. You can also
set up local users now, if you want.

These users are in addition to the system administrator and SL_internal users (and the repl_user,
if set up in Setting up replication at sites on page 30), which have full access to the local site or
entity.

If the user_local_mst table is not shared in the Intranet Shared User Tables form, then you must
update the multi-site group and other user fields at each site where the user record exists, even for
sites in the same database. If the AccountAuthorizations and/or UserGroupMap tables are not
shared, then you must update authorizations and groups at each site.

• You must specify a default authorization group for each user.
• For entity users, the authorization group should be Entity Forms. This will prevent users from

doing anything in the entity that is not supposed to be done in an entity.
• For site users, select an authorization group. For now, select one or more of the default

authorization groups. On the Users form, select one or more authorization groups for each
user from the drop-down list. (Later, after you become more familiar with the system, you may
want to set up new groups that more closely resemble your needs. Do not change the default
groups!)
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• To find out which forms are included in each default authorization group, go to the Groups
form. Select a group and then click Group Authorizations to list the forms that members of
this group can access.

• If you do not set up at least one authorization group for a user, then the user has access to
no forms, unless the user is set up with super user access.

• You must specify a default multi-site group for each user. This is the default value that appears
in the Multi-Site Group field when this user opens the Item Availability form.

• Select a user who will have General Ledger administration duties. Add the Enter Out of Date
Range group authorization for that user. This authorization is used to correct journal entries that
were incorrectly created in the wrong accounting period

• For mobile users, specify a Mobile Default Form on the Login Information tab. See the help topic
on setting up CloudSuite Business mobile access for more information.

• For developer users, if you are using a source control system, specify the user’s login information
for the source control system.

• If you have sites in multiple databases and you are not sharing user tables, you cannot replicate
the usernames or groupnames tables because those tables use identity columns. However, to
simplify the initial setup of multi-site users, you could add the multi-site users and groups in one
site, export the data to Excel spreadsheets, and import into sites in other databases. See Data
load to and from spreadsheets on page 95.

For sites in separate application databases, the user password, email addresses, and workstation
login can be set up in one site and replicated to the rest.

This is handled through the UserNamesRemoteUpdateSp in the Site Admin category.

However, the user record, assigned user module, authorization group and other required fields
must already be set up at the individual sites.

• If you have multiple sites or entities in one application database, any data stored in the
non-multi-site tables is shared across all of the sites and entities. This data includes the user ID,
password, and email addresses, as well as some other fields. However, certain other fields such
as multi-site group must be set up at each site and entity, if those other fields are in tables that
are not being shared.

• A warehouse (Whse) may be specified here but is not defined yet. You can return to this form
later to select the appropriate warehouse.

2 From the Users form, click User Authorizations to display the Object Authorizations for User
form, where you set up object authorizations for each new user record. Settings made here override
any group authorizations for this user.

Some of your users might require special access to certain forms that is not covered in the default
group authorizations.

For example, the user robertz is in the Purchasing authorization group, which has full access to the
Purchase Orders form. However, you do not want to allow robertz to delete POs.
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3 If you decided during the planning phase to use named user licensing, return to the Users form and
select a user record. Click User Modules to go to the User Modules form where you can set up
licensing for the selected user. Repeat this step for each user in the site. Use the Licensing
spreadsheet from your planning phase to help with this.

If you are using Intranet Licensing, the User Modules form is available only at the master site and
not at the participating sites.

See the Infor CloudSuite Business Licensing Administration Guide for more information about how
licensing works.

4 If the site will allow access from a CloudSuite Business portal, set up the portal users as described
in the Portal Administration Guide.

5 Run the User Authorization Report form if you want to have a list of authorization information for
each user, for auditing purposes.

If you have many common users between sites, in certain cases you can set up the users in one site
and then use the Copy User Tables utility to copy them to other sites.

For more information about how the utility works and when you can use it, see Copy User Tables utility
on page 113.

Adding external users
External customers or suppliers may be added as users on particular sites.

Since external users will log in remotely via the internet, the web server through which they will log in
should be configured to use https, so that data being transferred over the intranet is encrypted.
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Set up these users in Infor CloudSuite Business using authorizations that limit their access only to the
specific forms you want them to view. You may also want to limit their object authorizations to view-only,
as described in Adding common users on page 68.
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Chapter 10: Setting up supporting data

In each site, set up data that is required to support your transactions.

Note:  It is not necessary to set up supporting data at sites that are defined as financial entities.

The forms listed in this section add data to supporting tables that are used when entering customer,
vendor, and item information, creating transactions, and so on. Your company might not use some of
this data; in that case, you can skip those forms.

Note:  Be careful about the order in which the data is defined, so that table dependencies are not
violated, which will prevent records from loading. For example, product codes must be defined before
distribution accounts are defined, both of which must precede the definition of items. Items must be
defined before routings, BOMs, CO and PO lines, jobs, and so on.

The forms are listed in the order that the data should be entered because of data dependencies.

• Offices
• Companies: optionally includes CEO (from Employees, which is not available until later)
• Divisions: requires Company and Office, optionally includes Div Manager (from Employees, not

available until later)
• Departments: optionally includes Company, Office and Manager (from Employees, not available

until later)
• Price Codes: you might want to skip until later when items are defined
• Project Cost Codes
• Product Codes: optionally includes Price Code and Project Cost Code. Even though the account

fields are not required fields in this form, you must specify them now. When you add items later, the
product cost requires these associated accounts.

• Nature of Transaction Codes (NOTC)
• Secondary NOTC
• Carrier Codes
• Ship Via Codes: optionally includes Carrier Code
• Delivery Terms
• Warehouses: optionally includes Prov/State, Country, NOTC, Secondary NOTC, Delivery Terms

and Ship Via
• Distribution Accounts: requires Warehouse and Product Code (In-Transit account values default

from the product code)
• Tax Codes: requires Tax System - but there is a default Tax System 1 defined here, optionally

includes Tax Jurisdiction
• Tax Systems: requires Tax Code
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• Tax Jurisdictions: requires Tax System, optionally includes EC Code (from Countries form) and
Vendor number (not available until later)

• Billing Terms
• Reason Codes: there are many of these - use Form > Open and filter on reason to find them all.

Some of them optionally include NOTC and Secondary NOTC
• Scheduling Shifts
• Resource Types
• Resources: requires Resource Types and Shift Exception ID, optionally includes Item (not added

until later), Scheduling Shift, Fixed Asset Number (which in turn requires other data)
• Resource Groups: requires Resources
• Work Centers: requires Department, optionally includes Scheduling Shift and Resource Group
• Locations: optionally includes Work Centers
• Unit of Measure Codes: some U/M information is replicated between sites when the sites are

replicating the Centralized Order Entry, Inventory/Transfers, Purchase Order Builder, or Voucher
Builder categories

• Shift Codes
• Commodity Codes
• Language IDs
• Multi-Lingual Ship Via
• Multi-Lingual Terms
• Unit of Measure Conversions: requires Unit of Measure Codes
• End User Types
• Customer Types
• Vendor Categories
• Fixed Asset Class Codes: optionally includes Department
• Printers
• Territories
• Sales Periods
• Campaign Statuses, Campaign Types
• Lead Statuses
• Opportunity Task Types, Opportunity Sources, Opportunity Statuses, Opportunity Stages
• Email Types
• Lot Attributes
• Manufacturers
• Electronic Signature Setup
• Electronic Signature Authorizers

Simplifying the data load process
In many cases, you can create a spreadsheet based on the grid view of a form to copy and paste the
supporting data into CloudSuite Business.

See Data load to and from spreadsheets on page 95.
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Chapter 11:  Setting up operational data

Use these steps to set up operational data.

Data loads and replication
To speed up the data load, you might want to turn off replication before loading operational data.
Consider turning off replication if all of these statements are true:

• You are loading large amounts of data into tables, AND
• Those tables have triggers replicating to _all tables, AND
• Your system is replicating those _all tables between sites, AND
• Those _all tables reside at the local sites rather than at one master site.

In addition, there might be conflicts between data records being loaded at different sites (for example,
different customers with the same number). In that case, you might want to turn off replication before
loading the data, in order to minimize errors, and then deal with the conflicts later.

In the Sites/Entities form, click the Link Info tab and disable replication between sites before loading
the data in these cases.

After the load is complete, enable replication and run the Manual Replication Utility for the necessary
replication categories.

Setting up shared customers, vendors, and items
You might want an administrator to control adding, updating, and deleting shared customers, vendors,
and items across the system. Each site can control its local customer records, and these records are
independent of other sites.
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Adding shared customers through a master site
If you have set up a master site, use the Multi-Site Customers form at the master site to add customers
for all sites in the intranet. Instructions for using this form are in the online help. Appropriate replication
rules must be set up between the sites in order for the form to work.

See the chapter on master sites in the Infor CloudSuite Business Multi-Site Planning Guide for
information about the replication rules that are required.

Adding shared items through a master site
If you have set up a master site, use the Multi-Site Items form at the master site to add items for all
sites in the intranet. Instructions for using this form are in the online help. Appropriate replication rules
must be set up between the sites in order for the form to work.

See the chapter on master sites in the Infor CloudSuite Business Multi-Site Planning Guide for
information about the replication rules that are required.

Adding shared vendors through a master site
If you have set up a master site, use the Multi-Site Vendors form at the master site to add vendors
for all sites in the intranet. Instructions for using this form are in the online help. Appropriate replication
rules must be set up between the sites in order for the form to work.

See the chapter on master sites in the Infor CloudSuite Business Multi-Site Planning Guide for
information about the replication rules required.

Copying customers, vendors, or items through a master site
You can define a customer, vendor or item record in one site and then select Actions > Multi-Site
Copy in the Multi-Site Customers, Multi-Site Vendors, or Multi-Site Items form to copy the record
to other sites that are in the same intranet and multi-site group as the master site. BOMs are not copied
with item records when you use this method; use the Multi-Site BOM Builder form to copy the BOM
to the other sites.

Adding shared customers, vendors, and items without a
master site
As described in the Multi-Site Planning Guide, some customer, vendor, and/or item data may be
replicated when a new customer, vendor or item is added. However, the new record is not automatically
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displayed in the Customers, Vendors, and Items forms at the other sites. You must add it as described
below.

Adding shared customers without a master site
When a customer record is added in one site, it does not automatically populate in other shared sites.
If you want a customer to exist in multiple sites, first create it in one site and then add the existing
customer into other shared sites using these steps:

Note:  In the following description, "sharing sites" means all categories that contain the custaddr table
are being replicated between the sites.

1 In one site, go to the Customers form. Add and save the new customer records. The customer
number, name, and some other data from the custaddr table is replicated to sharing sites

2 At the other sites, go to the Customers form and select Actions > New.

3 Specify the customer number. The customer name, address, and some other information from the
custaddr table is displayed.

4 Fill in the rest of the information manually in the Customers form at the sharing site.

Adding shared (global) vendors without a master site
When a vendor record is added in one site, it does not automatically populate in other shared sites. If
you want a vendor to exist in multiple sites, first create it in one site and then add the existing vendor
into other sharing sites using these steps:

Note:  In the following description, "sharing sites" means all categories that contain the vendaddr table
are being replicated between the sites.

1 In one site, go to the Vendors form. Add and save the new vendor records. The vendor number,
name and some other information from the vendaddr table is replicated to sharing sites.

2 At the other sites, go to the Vendors form and select Actions > New.

3 Specify the vendor number. The vendor name, address and some other information from the vendaddr
table is displayed.

4 Fill in the rest of the information manually in the Vendors form at the sharing site.

Adding shared (global) items without a master site
When an item record is added in one site, it does not automatically populate in other shared sites. If
you want an item to exist in multiple sites, first create it in one site and then add the existing item into
other sharing sites using these steps:

Note:  In the following description, "sharing sites" means the Centralized Order Entry category and/or
the Inventory/Transfers category are being replicated between the sites.

1 In one site, go to the Items form and add and save the items. The item numbers, descriptions and
U/M values are replicated to sharing sites - but the new items will not automatically appear in the
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Items form at the sharing sites. This information will, however, appear in the Global Items form at
the sharing sites.

2 In the sharing sites, go to the Items form and select Actions > New.

3 Specify the item number. The system enters the default values from the Global Items form into
these fields: Item, Description, and U/M.

4 Fill in the rest of the item record manually at the sharing site.

The Global Items form also contains a default Shipping Site, which is used to determine how the
Customer Order Lineship site defaults when entering a centralized order for the item.

Typically, shared sites have identical Global Items default values when all sites are within the same
country. If sites are in different countries, the Description and U/M fields can be updated as required.

Alternative methods for copying records
Another way to duplicate vendor, customer or item records in multiple sites is to create the records in
one site, export them to a spreadsheet, and import the spreadsheet into the same form at the new site.
(Make sure the form's grid columns are arranged in the same order at both sites.) See Data load to
and from spreadsheets on page 95 for more information.

If your sites are accessible through a single computer, you also may be able to use the right-click Copy
feature to copy the item rows from the Customers, Vendors, or Items form on one site and then select
Edit > Paste Rows Append to add them at the other site.

Setting up employees
On the Employees form, specify information about each employee. Fill in at least the required fields,
which are used in other areas of the system.

Setting up other operational data
1 In each site, set up current routings and BOMs.

2 In each site, set up beginning balances for accounts in the Journal Entries form.

3 In each site, set up units on the Units form.
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Chapter 12: Setting up other modules and products

After you have set up the base CloudSuite Business multi-site system, you can install and configure
other modules and products according to the documentation listed in this table.

SeeProduct or module

Infor CloudSuite Business APS Configuration Guide

Infor CloudSuite Business Installation Guide

online help

APS

Guide to the Application Event System, online helpApplication Event System

Infor CloudSuite Business Analytics Administration Guide

Infor CloudSuite Business Analytics Installation and Configuration
Guide

CloudSuite Business Analytics

Infor CloudSuite Business Integration Guide for CelergoCelergo

Infor CloudSuite Business Integration Guide for Infor CPMInfor CPM (PM 10)

Online helpCountry Packs/Localizations

Infor CloudSuite Business Credit Card Interface Configuration Guide,
online help

Credit Card Interface

Infor CloudSuite Business Integration Guide for Infor CRMInfor CRM

Infor CloudSuite Business Integration Guide for Infor CRM Back Office
Connect

Infor CRM Back Office Con-
nect

Online helpData Collection background
tasks

Infor CloudSuite Business Integration Guide for Infor EAMInfor EAM

Online helpEDI

Online helpEFT (bank reconciliations,
customer payments)

Infor CloudSuite Business Integration Guide for Infor e-Commercee-Commerce

Infor CloudSuite Business Enterprise Financials Interface Installation
Guide

Infor CloudSuite BusinessEn-
terprise Financials (SunSys-
tems interface)
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SeeProduct or module

Infor CloudSuite Business Installation GuideInfor Framework FAX Service

Infor CloudSuite Business Integration Guide for Infor Global FinancialsInfor Global Financials (Varial)

Online helpIndustry Packs

Infor CloudSuite Business Integration Guide for Infor Local.lyInfor Local.ly

Portals installation and administration guidesPortals

Infor CloudSuite Business Microsoft Office Integration User Guide,
online help

Microsoft Office

Online help, mobile user guidesMobile

IInfor CloudSuite Business Installation Guide.NET Web Service

Infor CloudSuite Business Installation GuideOnline help

Online helpPayroll Interface

Infor CloudSuite Business Integration Guide for PLM, online help

Infor CloudSuite Business Integration Guide for PLM Accelerate

Infor PLM or Infor PLM Accel-
erate

Various CPQ installation, upgrade, integration, and reference guides,
CloudSuite Business online help

Infor Configure Price Quote
(CPQ)

Online helpProduct Configurator (Fea-
tures and Options)

Infor CloudSuite Business Integration Guide for Infor Road WarriorInfor Road Warrior

Infor CloudSuite Business Integration Guide for Infor SCE Warehouse
Management

Infor SCE Warehouse Manage-
ment

Infor CloudSuite Business Tax System Interface Configuration Guide,
online help

Tax Interface

Contact Infor Consulting ServicesInfor Factory Track

Infor CloudSuite Business Configuration Guide for Infor Operating
Service

Infor CloudSuite Business User Guide for Infor Operating Service

Infor Operating Service (Infor
Ming.le, ION, Infor Document
Management, In- Context BI)

Some of these products are installed as part of the CloudSuite Business installation, but are licensed
separately. These products are licensed for an application database, but you must also use the Optional
Modules form in CloudSuite Business to enable the products for each site. For more information, see
the Licensing Administration Guide.
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Appendix A: Troubleshooting

Use this information to find and fix problems.

Handling replication errors
Use this information to find and fix problems with the replication of data.

Errors during transactional replication
Validation errors relating to transactional replication generally display during data entry or saving of
transaction records at the local site, and do not allow the user to continue.

However, if transactional replication appears to not be working (that is, the data is not being moved to
the target site as expected) and the cause is not immediately apparent, see Replication troubleshooting
checklist on page 81.

Errors during non-transactional replication
If errors occur when sending or receiving XML request documents through CloudSuite Business’s
replication system, the processes shown in this flow handle the errors.
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Replication troubleshooting checklist
If replication does not seem to be working, view the appropriate _all table(s) using SQL Server tools,
to determine if data is being populated.

For example, a newly added item is not available from a drop-down menu in another, replicating site.
View the item_all table to see if data is being populated.

If replication is not working, the table typically does not contain the newly entered data records. In this
case, there probably is a problem with the replication rules.

For replication problems, check these areas:

1 Configuration Manager utility: Verify, for each site and entity, that one of these cases is true:
• A default configuration name is defined for that site on the Sites/Entities form, or
• You have created at least one configuration name that exactly matches the site/entity ID, including

case, and that uses the site/entity’s application database.

2 Replication Rules form: Ensure that the rules are set up properly between the site where the data
was added and the one where the data was supposed to appear.

Are the proper categories being replicated?

Use this table to see what types of results to expect on the target site for each replicated category.
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Expected results on target site (for forms with Site or Site Group fields)Category

Posted A/P vouchers, adjustments and payments from source sites are visible
on view forms.

A/P reports contain data from source sites.

_all tables contain account, currency, item, journal, period, vendor and tax infor-
mation from source sites.

A/P

Posted A/R invoices, debit memos, credit memos and payments from source sites
are visible on view forms.

A/P reports contain data from source sites.

_all tables contain account, currency, item, journal, period, customer and tax in-
formation from source sites.

A/R

Credit card authorization information is replicated from the source site.CCI Centralized
Order Entry

Customer orders with lines that have a local ship site are visible.

Transfer orders to or from the local site are visible.

_all tables contain customer, customer order, account, currency, item, job, period,
purchase order, project, transfer order and tax information from source sites.

Centralized Order
Entry

Portal users can see item pricing. B2B users can see that prices are from multiple
sites.

Customer Portal

View dimensions and attributes at other sites.Dimensions

Data is received in other BOD-enabled application; acknowledgement data is re-
ceived in CloudSuite Business.

ESB

Not typically used between CloudSuite Business sites.EXTFIN

Not typically used between CloudSuite Business sites.EXTFIN Cus-
tomer

Not typically used between CloudSuite Business sites.EXTFIN Vendor

Financial and G/L reports and views show data from source sites.

_all tables contain ledger, account, currency, period, and journal information from
source sites.

G/L

N/A. Used only during replication setup.Initialize _All Pa-
rameters

Transfer orders to or from the local site are visible.

_all tables contain account, currency, item, job, period, and transfer order informa-
tion from source sites.

Inventory/Trans-
fers

Invoices for customer order shipments and returns can be created at target sites.Invoice Builder

Not used for CloudSuite Business.ION
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Expected results on target site (for forms with Site or Site Group fields)Category

Pending journal transactions created by Journal Builder in source site appear in
the local site.

Journal Builder site can validate data from the local site.

Journal Builder

Ledger records are consolidated from source sites when invoked.

_all tables contain account, currency, and period information from source sites.

Ledger Consolida-
tion

Ability to drill down into G/L records from remote sites if transaction data is also
replicated.

_all tables contain account, material transaction and voucher pre-register informa-
tion from source sites.

Ledger Detail

_all tables contain manufacturer and manufacturer item information and cross-
reference information between manufacturer item and CloudSuite Business item
records from source sites.

Manufacturer
Item

This applies to the Multi-Site Buyer, Controller, CRM, Customer Service, In-
ventory Control, Production Planner, and Project Manager categories: On the
various Home forms, information from source sites is visible.

Multi-Site (home
forms)

On the Multi-Site Customers form, customer information that is defined on source
sites is visible.

Multi-Site Cus-
tomers

On the Multi-Site Customers form, item information that is defined on source
sites is visible.

Multi-Site Items

Planning is invoked for source sites when specified.

Planning views include requirements and receipts for source sites.

Planning

Upon receiving a customer’s order, the demanding site automatically creates a
PO and links it to the source site.

PO-CO Across
Sites

POs are created in the local sites with data entered at the source site through the
Purchase Order Builder.

Purchase Order Builder site can validate data from the local site.

Purchase Order
Builder

Incidents and associated events, reasons and resolutions are replicated from the
source site.

Service - Global
Incidents

Scheduled appointments for Service are replicated from the source site.Service - Global
Scheduling
Shared Partners

Summarized history information about Incidents, service orders, and units are
replicated from the source site.

Service - Global
Service History

Units and their component configuration, warranty information and owner history
are replicated from the source site.

Service - Global
Units

Users can trigger the copy of a service order from the source site to the target
site.

Service - Multi-
Site SRO Copy

Currency information from source sites is visible.Shared Currency
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Expected results on target site (for forms with Site or Site Group fields)Category

Site and intranet information from source sites is visible.

_all tables contain account information from source sites.

Site Admin

Vendor portal users can see purchase orders initiated from multiple sites.Vendor Portal

Vouchers and adjustments are created in the local sites with data entered at the
source site through the Voucher Builder.

Vouchers are created in the local sites with data entered at the source site through
the Manual Voucher Builder.

The Voucher Builder site, or the Manual Voucher Builder site, can validate data
from the local site.

Voucher Builder

a View the Replication Rules form in the source site (for example, if you're expecting to see CAL
data in ONT, view the CAL database), and determine if there is a rule set up with Target Site
set to the site where you expect to see the data, and with Category set to the category as
determined above.

b If such a record does not exist, this means the behavior was expected. You can create a new
rule if desired, and retest to verify that the data was passed over.

c If the record exists, check its Interval Type:
• If the Interval Type is Transactional, there might be another problem with the replication

setup. Continue through the other steps in this checklist.
• If the Interval Type is Immediate, there might be a problem with the setup of the replication

services.
• If the Interval Type is something other than Transactional or Immediate, wait until the time

specified in Start Interval At before testing again. If the interval time has passed and the
change has still not occurred on the target machine, there might be a problem with the setup
of the replication services.

3 Sites or Sites/Entities form: Ensure that the database name and the linked servers (for transactional
replication) or user maps (for non-transactional replication) are set up correctly.

4 Replication Management form: You must click the Regenerate Replication Triggers button on
this form after any replication rules have been changed. Failure to do so will result in replication not
working properly.

5 Find Replication Setup Issues form: Use this form to find problems relating to the setup of replication
from the current site to another site for a particular database table or stored procedure.

Not all problems found by this utility are valid in all situations. For example, it checks to see if a user
name is set up between the sites, which applies only if non-transactional replication is being used.

6 Replication Errors form: This form shows the data that failed to submit to a target site during
non-transactional replication. Use the form to fix and resubmit data, or delete it.

7 Replication Tool: This tool on the utility server is used to troubleshoot non-transactional replication.
8 ReplicatedRows3 and ShadowValues tables: When something is to be replicated through

non-transactional replication, it gets copied to the ReplicatedRows3 and ShadowValues tables. See
the Infor Mongoose Replication Reference Guide for details. If the data is not there, it is likely that
either your replication rules are not set properly or that you need to click the Regenerate Replication
Triggers button on the Replication Management form.
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9 Services: If you are using non-transactional replication, make sure the Infor Replication Queue
Listener and Infor Replicator services are started on the utility server.

10 MSMQ or Message Queuing: Turn on journaling.
11 Event Viewer: Check the event viewer in the Windows Administrative Tools on the utility server or

database server. The events that are logged may give you a clue about where replication failed.
12 UETs: If you are using user extended tables, and the UET information is not replicating properly,

see the information about UETs and _all tables in the Infor Mongoose Replication Reference Guide.

Common replication solutions

Problem: System performance is slow and you suspect replication may be causing this.

Solution: Check these areas:

1 Use the stored procedure sp_spaceused (in the Master database) to determine which tables consume
a lot of space.

2 If there are _all tables (that is, replicated data) that contain very large numbers of records, then
make sure you are not replicating unnecessary data.

See the Replication Categories chapter in the Infor CloudSuite Business Multi-Site Planning Guide,
particularly the information about replicating financial data.

Also look at the descriptions of how the tables in each category are used. If your large _all tables
are used only for reports that you rarely or never require, you might be able to remove that object
from the category.

Before you make changes to replication categories, seriously consider requesting help from your
Infor CloudSuite Business provider or Infor Consulting Services.

3 See also the information on improving system performance in the Infor CloudSuite Business
Administration Guide.

Problem: Replication failure due to SQL Linked Server error

If your system returns an error like one of these, the local server probably no longer has a link to itself:

• Server ’servername' is not configured for Data Access. Distributed
Transaction Completed. Either enlist this session in a new transaction or
the NULL transaction.

• New transaction cannot enlist in the specified transaction coordinator.
• The operation could not be performed because the OLE provider 'SQLOLEDB'

was unable to begin a distributed transaction.

Solution: To fix this problem, run these SQL commands on the application database:

exec sp_addserver servername, LOCAL  

-- restart SQL Server.

EXEC sp_serveroption 'servername', 'Data Access', 'True'
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Replace servername with the name of the local server.

Problem: Invalid Column name UF_xxxx

If your system returns an error message similar to this during replication, you may have user extended
tables (UETs) set up in one site but not in another, in separate databases.

Solution: You must have identical schemas in all sites to replicate data.

If one site contains UET modifications to a table, but the same table in another site does not contain
those modifications, errors probably will be generated during replication of that table’s data from one
site to the other.

For that reason, before you replicate data between sites, you should copy any UET schema changes
to all sites involved in the replication. A stored procedure, ExportUETClassSp, assists in handling this
process.

Problem: Outbound BODs are not being sent from the ERP to another system

Solution: Follow these steps to determine the cause:

1 Does the BOD appear in the Replication Document Outbox?

(BODs are saved in the outbox after processing only if the BOD service is configured to not delete
them.)

If yes, continue to the next step.

If no, then do this:

a If this is a multi-site system, verify that you are checking the outbox on a site that is defined in
the Replicator/Inbound Bus Configurations area in the Service Configuration Manager utility.

b From the CloudSuite Business utility server, run the LogMonitor utility.
c In the CloudSuite Business application, perform the processing that should send the BOD. (See

the Replication Document Outbound Cross References form for a list of the application events
that generate the BOD.)

d In the LogMonitor utility, look for ReplQListener log information that might indicate an error in the
BOD processing.

2 Is the Processed check box selected?

If yes, the BOD was picked up by the BOD service. Check in the ION application for details.

If no, then there is a problem that is preventing the BOD service from picking up the message. Either
the service is not running, or the configuration and deployment of the sending/receiving applications
is not set up properly in the receiving application(s).

Problem: Inbound BODs are not being received or processed by the ERP

Solution: Follow these steps to determine the cause:

1 Does the BOD appear in the Replication Document Inbox?

(If there are many documents in the inbox, it can be difficult to find the BOD because currently you
cannot filter by BOD name.)

If yes, continue to the next step.

If no, then something prevented it from being delivered by the BOD service:

Infor CloudSuite Business Multi-Site Implementation Guide | 86

 

Troubleshooting



a If this is a multi-site system, verify that you are looking at the inbox on a site that is defined in
the Replicator/Inbound Bus Configurations area in the Service Configuration Manager.

b Check the BOD service logs to find failed message transmissions or information about why the
failure occurred.

c Check whether the BOD service is running.
d Check whether the configuration and deployment of the sending/receiving applications is set up

properly. See the appropriate integration guide for more information.
2 Is the Processed check box selected?

If yes, and the expected information does not appear in the appropriate CloudSuite Business form
or table, then there was an error in processing. Check the Replication Document Outbox for a
Confirmation BOD. A confirmation BOD indicates an error.

Check these areas to determine the cause of the error:

• Windows application event viewer
• LogMonitor utility on the utility server, if it is running

If no, then either the Infor Framework Inbound Bus Service is not running, or it is still working through
previous messages.

Problem: After adding a site in a different database, replication is not working

If all sites were previously in the same application database, and you add a site in a different application
database, you must regenerate views and replication triggers, and repopulate _all tables.

Solution: Follow these steps in one site in each application database:

1 In the Trigger Management form, leave the fields blank and click Generate to regenerate table
triggers. (This is not related to replication, but it must be done after you add a new site in another
database.)

2 If any new replication rules were set up to/from the new site, open the Replication Management
form and click Regenerate Replication Triggers.

3 In the View Management form, leave the fields blank and click Generate to regenerate views over
tables.

4 Restart the replication services on the utility server.
5 In the Update _All Tables form, select all tables, set Site to the current site and click Repopulate.

This step must be performed at every site and entity.

Problem: Error occurs in the Replication Document Manual Request Utility due to timeout

If you receive either of these errors during generation of BODs through the Replication Document
Manual Request utility, then transactions are taking longer to run than the timeout values set in
CloudSuite Business or other related applications and services.

Exception from load collection: Error processing an IDO request 

(Protocol=Http, URL=http://servername/IDORequestService/RequestService.as►
px): 

The remote server returned an error: (500) Internal Server Error.
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BOD generation errors

If you receive either of these errors during generation of BODs through the Replication Document
Manual Request utility, then transactions are taking longer to run than the timeout values set in
CloudSuite Business or other related applications and services.

Exception from load collection: Error processing an IDO request 

(Protocol=Http, URL=http://jokerswild/IDORequestService/RequestService.as►
px): 

The remote server returned an error: (500) Internal Server Error.

or

The transaction has aborted.

Transaction Timeout

Solution: For a list of timeout values that can be reset, see the chapter on improving performance in
the CloudSuite Business Administration Guide.

Problem: The Multi-Site Customers, Multi-Site Items, or Multi-Site Vendors form is not showing
drop-down values for the selected site

Solution: Make sure that the replication rules are set up between the sites as described in the online
help for the multi-site form. Then regenerate the replication triggers at each of the sites involved.

Forms and utilities that are used to troubleshoot replication
Use these forms and utilities.

Replication Tool (inbound or outbound flow)

If errors happen while CloudSuite Business replication is processing an inbound or outbound request,
you can use the Replication Tool on the utility server to perform these actions:

• View, correct, and resubmit inbound and outbound XML request documents
• View the status of sites linked to this site for replication

The Replication Tool can be used to view errors in any XML being sent from Infor CloudSuite Business
to a different CloudSuite Business intranet or an external system. Navigate to All Programs > Infor >
Tools > Replication Tool or find the Replication Tool under Apps.
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The Configuration and Listener queues are shown in the drop-down lists. Select them as the default
to use in the other windows of this utility.

Service Configuration Manager setup

Before you run the Replication Tool, use the Service Configuration Manager utility to configure replication
options on the Replication tab. Then click Save to save these settings in the service configuration
XML file specified on the General tab.

Instructions for using the Replication Tool and Service Configuration Manager are found in the online
help for those utilities.

Replication Errors form, inbound flow

During non-transactional replication, if an XML document makes it into an CloudSuite Business intranet,
is retrieved from the inbound MSMQ by the Replication Queue Listener, but fails when executed against
the target site, its errors are displayed in the application's Replication Errors form on the target site.
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Generally these documents contain valid login and target site information but are failing for another
reason.

If an inbound XML document fails before that point, you can view and correct it through the Replication
Tool.

Use the Replication Errors form to fix and resubmit the data. If the update succeeds this time, the
data is removed from the ShadowValuesErrors table; if it fails again, it will remain in the table.

These are the fields of interest:

• From Site: Site where the record orginated.
• Object Name/Object Type: Name and type of record to be replicated.

For example, the co table might be replicated.

• Operation Number: Distinguishes different elements in the errors.

For example, an insert of an item record might use several lines of old and new values, all with the
same Operation Number.

• Operation Type: Type of operation: insert, update, delete, or method call.
• Line: Indicates which line of data for a particular record contained the error. The data is stored in

rows of 55 name/value pairs, so for example, if there are 85 columns of data, there will be 2 lines.
• Old/New: Indicates whether a particular row of the collection represents the old or new values. For

updates, the old values are also displayed.
• Error: Text of the error message received when this record was submitted.
• Label: Label seen on forms.
• Value: Data for a particular column. For example, the column "Description" might have data "bike

seat" as a value.

Find Replication Setup Issue form

If you know that a specific object, for example, a table, is not replicating changes from the current site
to another site, use this form to help troubleshoot why replication is not occurring.

You enter an object name and type (a table, stored procedure, or XML document) and select the remote
site name. When you click List Issues, any setup errors for that site/object combination are listed.
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These are some of the setup problems that might be displayed:

• The From Site or To Site does not exist in the site table.
• No replication category contains the specified object (table, SP, etc.).
• No replication rule exists for the specified From Site and To Site, and for any category that contains

the specified object.
• A rule exists for a category using the specified object, but the rule is currently disabled on the

Replication Rules form.
• Replication is currently disabled between the specified From Site and To Site on the Sites or

Sites/Entitiesform.
• No replication trigger exists for the specified object (if it is a table), or the trigger is disabled.
• The To Site has not been set up with a linked server name on the Sites or Sites/Entities form or

through the Infor CloudSuite Business Configuration Wizard. (Transactional replication) Transactional
replication checks are made only if at least one transactional replication rule is enabled at this site.

• The To and From sites are on different database servers, and the To Site’s database server has
no link to it from this site’s database server. This is established through the Linked Servers node in
SQL Server. (Transactional replication)

• The To Site’s database name is not specified on the Sites or Sites/Entitiesform. (Transactional
replication)

• The user name specified for this From Site and To Site does not exist. (Non-Transactional replication)
• The replication user name is not a super user or has not been given access to the proper license

module and group. (Non-Transactional replication)
• The To Site and/or From Site does not have an Intranet defined on the Sites or Sites/Entities form.

(Non-Transactional replication)
• The To Site's intranet has no URL defined on the Intranets form. This is a problem only if the To

Site is on a different intranet than the From Site. (Non-Transactional replication)

If no problems are found, the replication triggers may just need to be regenerated.

Troubleshooting other setup problems
You might encounter other error messages during implementation. One common message and its
solution is described here.

Message: Maximum Number of Databases Used for Each Query has been Exceeded

Solution: Close and restart the Infor CloudSuite Business session where the error occurred. Retry the
procedure you were running at the time of the error.

If you still get the error, close all open Infor CloudSuite Business sessions and restart only the one for
the configuration you were in when the error occurred. Retry the procedure that caused the error.
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Framework logging
All framework logging, from sources such as WinStudio, TaskMan, Replicator, and the IDO Runtime
Service, is sent to a common logging routine. This log information can be viewed on the utility server
through the Log Monitor utility, which is found in the program/app area under Infor > Tools > Log
Monitor.

Information that is sent to the logs while the Log Monitor program is not running is not stored anywhere.
If a developer is using the IDO Runtime Development Server instead of the Log Monitor, that program
displays logging information.
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Appendix B: Setting up a test environment

Note:  See the Infor Xtreme Support web site for the latest information about how to request license
keys for demo or pilot databases.

Before you "go live" with a multi-site environment, you probably want to set up a test environment,
possibly with your company's data. Follow the steps below to set up a multi-site test environment with
transactional replication:

1 Create one test site.

You have 2 choices:

• Create an initialized application database that contains a “demo” site with data provided by Infor.
This is described in the Infor CloudSuite Business Installation Guide.

• If you have already set up a site using this version of Infor CloudSuite Business with your data
in a "test" single-site environment, you can use that site as your initial site.

2 Repeat step 1 to create more application databases with different site names.

Note:  The demo site has an invoice length to 10, so all of your test sites must have an invoice
length of 10 if you are using any demo sites in your multi-site test setup.

3 If you want to have multiple sites in a database, choose one of your existing application databases
as the target. Copy sites from your other application databases into the target database, using the
Add New Site to an Existing Database option in the Configuration Wizard.

See Copying an existing site into an existing database (multiple sites per database) on page 108 for
additional instructions.

4 Create at least one forms database. If you use the same forms database for both your live and test
environments, be aware that any form customizations you make are then applied to both
environments.

5 Create at least one object database.

6 On the database server, run the CloudSuite Business Configuration Wizard to link all the sites that
you want in your multi-site environment.

7 On the utility server, use the Configuration Manager to create client configurations that point to the
new sites.

8 On the utility server, use the Service Configuration Manager to set up monitoring of your new
configurations for TaskMan, non-transactional replication, and the application event system.

9 Log into one site configuration on each application database as the system administrator and perform
these steps:

a In the License Management form, specify the license for this database.

If you need to request special licenses, see the section about licensing Demo and Pilot databases
in the Infor CloudSuite Business Licensing Administration Guide.

Infor CloudSuite Business Multi-Site Implementation Guide | 93

 

Setting up a test environment



b In the Sites or Sites/Entities form, ensure that the application and forms database names are
set for each site in this database.

c Log out.

10 Log into each site and set up replication rules and/or shared tables between all the sites.

See Setting up replication at sites on page 30.
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Appendix C: Data load to and from spreadsheets

If you have many sites with similar data to be entered at each site, it may make sense to load the data
into the system from a spreadsheet. The spreadsheet method only works well if you have smaller
volumes of data. It is much more difficult to deal with errors in spreadsheets when you are trying to
load a large number of records at once.

Note:  Consider using Infor Consulting Services if you have larger volumes of data to load. Contact
your Infor representative for more information.

Requirements for loading data from spreadsheets
• Make sure the columns in the spreadsheet exactly match the order of the grid in the form, and that

the data is in the format required by the form. The best way to do this is to create several sample
records in the CloudSuite Business form and then export them to a spreadsheet. Then use that data
as a template for the other rows. Or you may want to create a "demo" database and export the
sample data to use as a template. In the template, you may want to hide columns for data that
comes from calculated or read-only fields so that you do not enter data into them accidentally. Do
not delete these columns; otherwise the columns will not match up when you paste them back into
CloudSuite Business.

• Make sure any supporting data has already been loaded.

For example, if you try to load a customer address that includes IN as the state, but a Prov/States
record does not yet exist for IN, the system sends a validation error and stops importing.

Exporting data from a form to a spreadsheet
To quickly create a spreadsheet that contains all the rows in the current form’s grid, including the header
rows, use this process:

1 In the form’s grid, select the rows by shift-clicking in the row numbers on the left.
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You can use Ctrl-2 to toggle between the grid view and the form view.

2 Type Ctrl-C to copy the rows to the clipboard.

3 Open a spreadsheet and paste the rows into it. Notice that some columns are empty and some are
set to a different format than appears in the form (for example, 0’s and 1’s instead of checkboxes).

Caution:  The Actions > To Excel menu option is also available, but it is intended for export of
data to other applications, not for updating data that will be imported back into CloudSuite Business.
By default, this option saves the columns in the order they appear in the IDO collection, which may
not be the same order that they appear in the grid. (However, you can choose to match the sequence
of columns in the grid.) Also, be aware that cells with data that contains hard and soft returns might
not work as expected with the To Excel option. In addition, the To Excel output might include cells
that are hidden on the grid. Be careful to ensure that the order of the cells are the same as the
grid if you plan to copy the cells back into the application.

Importing data from a spreadsheet into a form
1 Ensure that the columns in the spreadsheet are in the same order as the columns in the form’s grid.

2 In the spreadsheet, select the rows by shift-clicking in the row numbers on the left.

3 Right-click and select Copy.Specify this information:

4 Ensure that the form is in "Add" mode. that is, the Create a New Object toolbar button is enabled.

5 In the form’s grid, click in the left column of the first empty row.

6 Select Edit > Paste Rows Append. The rows are added in the grid.

Infor CloudSuite Business Multi-Site Implementation Guide | 96

 

Data load to and from spreadsheets



7 Click the Save button to save the rows.

The copy works only if all the information in the rows is valid and in the proper format. Otherwise, you
get data validation errors and the import stops. See Requirements for loading data from spreadsheets
on page 95.

When the system encounters an error, it asks if you want to correct the field. If you answer Yes, the
import stops. If you answer No, the system continues pasting the rest of the rows. When it completes,
you can correct the rows marked with "ne" in the CloudSuite Business form.
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Appendix D: Removing a site from an existing system

Note:  Be aware that, if you remove a master site, these features that depend on having a master site
are no longer available:
• Multi-Site Customers, Multi-Site Items, and Multi-Site Vendors forms
• Intranet licensing

The steps below describe removal of a site or entity that exists by itself in an application database.

There currently is no way to remove one site or entity from a multi-site application database. In that
case, you would copy the site to one new database, then copy all of the other sites to another new
database, then remove the original database that previously contained all of the sites. See the steps
in Copying an existing site into an existing database (multiple sites per database) on page 108. Also
see the description of "Problem: after adding a site in a different database, replication is not working"
in Common replication solutions on page 85. Many of the logical separation steps described in this
topic would still apply in that case.

For more information on any step, see the online help.

1 If the site or entity currently reports to an entity and general ledger activity has been performed at
the site, complete these steps:

a Post and consolidate all journals and the ledger for transactions in the current site. Run the
Ledger Consolidation activity at each site to calculate the ending balances for every account
number at the site and consolidate them up through the old entity hierarchy.

b Because the full account balances will be closed out and moved, any balances that are to remain
in the old structure must be manually transferred to other sites by journal entries in both sites.
Post and consolidate those journal entries.

2 If a site is being removed from a reporting hierarchy (that is, it currently reports to an entity) the
Change Reports To utility should be run at the site, with the Reports To field blank.

3 If an entity is being removed from a reporting hierarchy:

a Run the Change Reports To utility at sites reporting to that entity, to change the hierarchy so
that no sites are reporting to it.

b If the entity also reported to a higher-level entity, run the Change Reports To utility at the entity
being removed, with the Reports To field blank.

4 Ensure that all other users are logged out of the site. If you are removing a master site, all users
must be logged out of all sites on the master sites’ intranet. If the remaining sites are all in one
application database, and the removed site is the only site not in that database, all users must be
logged out of that application database.

5 If the site belongs to an intranet that is sharing tables:
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a Go to the master site’s Intranet Shared Tables form and unshare all the shared _all tables. This
adds the shared tables back to all of the sites in the intranet.

b Go to the master site’s Intranet Shared User Tables form and unshare the shared user tables.
This adds the shared user tables back to all of the sites in the intranet.

c At the site being removed, go to the Sites or Sites/Entities form and change the Intranet value
to some other intranet (or make it blank).

d If the site being removed is the master site for the shared intranet, log into the master site. On
the Intranets form, clear the Master Site field. This should replicate to all the other sites in the
shared intranet.

6 If the site being removed uses intranet licensing, deselect the Intranet Licensing check box on the
Sites or Sites/Entitiesform and save the record.

If the site being removed is a master site using intranet licensing, you must also deselect the Intranet
Licensing field at all slave sites and then apply a license at each site.

Note:  Turning Intranet Licensing off at a site requires that a license document be applied to that
site. It may also result in incomplete licensing on that site for some user-created objects, because
the ModuleMembers records created for new and copied forms will have been created in the master
site application database and in the originator's site application database. If Intranet Licensing at a
site is disabled, and if it is not the master site or the site from which the new or copy action was
originated, then the appropriate ModuleMember licensing records for those user-created forms and
IDOs are not present in the application database of that site.

Users cannot access sites where you have turned off intranet licensing until you either set up specific
licensing for that site, or set up a new master site with intranet licensing and then reselect the
Intranet Licensing check box at the master and slave sites.

7 Remove replication rules in these areas:

• from other sites to the site being removed

• from the site being removed to other sites.

8 If the removed site uses a linked server definition to connect to other sites (see step 9 in Linking
databases on page 14), change the linked server setup within SQL Server or with the Configuration
Wizard on the database server.

9 If the remaining sites are all in one application database, and the removed site is the only site not
in that database, use the Update _All Tables form to truncate the _all tables in each site.

10 Delete the removed site’s record in the Sites or Sites/Entities form at the other sites.

Since the Site Admin category is replicated between all sites, removing the site record from one
site should remove it from all of the others. Verify this at each site.

You might need to delete data relating to the removed site, so that Infor CloudSuite Business will
allow the deletion of the removed site’s records on the Sites or Sites/Entities form. If so, an error
message displays information about the problem. You can also use SQL queries to review any data
that references the site, to make sure you are not leaving databases in a state where orphaned data
causes issues with functionality.

Some records for the site are automatically removed by the system. For example, the site’s record
is removed from the Site Groups form.

Site records remaining in _all tables should not cause problems with the application. However, they
do take up space in the database. See step 16.
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11 If the remaining sites are all in one application database, and the removed site is the only site not
in that database, use the View Management and Trigger Management forms to regenerate the
views and table triggers in that application database.

12 Optionally, if the site that is being removed was the master site, specify a new master site. Log into
the site that will be the new master site. On the Intranets form, select the shared intranet. In the
Master Site field, select this site to specify it as the master site for the intranet.

13 At the master site, delete any references to the removed site in the Sites or Sites/Entities form’s
Link Info tab.

14 In the removed site, delete records for the other sites in the Sites or Sites/Entities form. See the
Note above.

15 Regenerate the replication triggers at all sites.

16 You may want to use the Update _All Tables utility to truncate and repopulate the _all tables,
deleting references to the removed site. Or you may want to temporarily preserve the site records
in the _all tables for later auditing. If you choose to truncate/repopulate, perform the truncation at
all sites first; then perform the repopulation at all sites. (If you truncated the tables in step 9, you
can skip this step.)

17 If the site was removed from an intranet with shared _all tables, go to the master site. Open the
Intranet Shared Tables form and re-share the shared _all tables that you unshared in step 5.

18 If the site was removed from an intranet with shared user tables, go to the master site. Open the
Intranet Shared User Tables form and re-share the shared user tables that you unshared in step
5.

19 In the Service Configuration Manager on the utility server, if the removed site’s configurations were
being monitored by the Replication/Inbound Bus services, or by TaskMan or the Event Service,
remove the configurations from the list of monitored configurations.

20 In the Configuration Manager on the utility server, remove the site’s configurations from any
configuration groups, and remove or edit the configuration definitions.

21 Restart the Infor Framework services on the utility server to pick up the configuration changes.

After you remove this site from its current system, you might want to add it to another CloudSuite
Business multi-site system.
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Appendix E: Adding a site or entity to an existing
shared tables intranet

After your multi-site system is set up and running, you might need to add a site to it. Use this chart to
find the instructions to use:

SeeAdding to a database withNew or existing

Adding a new site or entity to an ex-
isting system (one site per database)
on page 102

One site per databaseNew site or entity

Adding new sites and entities to an
existing application database on
page 16

Multiple sites per databaseNew site or entity

Adding an existing site or entity to
an existing system (one site per
database) on page 106

One site per databaseExisting site or entity

Copying an existing site into an ex-
isting database (multiple sites per
database) on page 108

Multiple sites per databaseExisting site or entity

To simplify the explanation of this process, these site names are used in examples in this chapter:

• OH is the master site on the existing shared tables intranet.
• MI and CA are other sites on the intranet.
• IN is the site being added to the intranet.

About manual replication

During this process, one of the steps you will perform is manual replication from the master site to the
new site.

Before you can perform manual replication from the master site, site records must already exist in the
target database (the new site) for all sites in the master site’s intranet. That is, if the master site’s
intranet includes OH (the master site), MI, CA, and KY, and you are adding the new site IN, then you
must create site records in the IN site for OH, MI, CA and KY, before you run manual replication from
the master site (OH) to the new site (IN). You should only fill in the site name and time zone when you
create the other site records at IN. During manual replication, the site records at IN are overwritten
with the information from the site records at OH.
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Adding a new site or entity to an existing system (one
site per database)
To add a new site or entity with no existing data to an existing multi-site system with a master site and
shared tables intranet, follow these steps. See the relevant chapters earlier in this guide for additional
details about any step.

Note:  Back up all existing databases before starting this process.

1 On the database server, create the additional site or entity database as described in Creating
additional site databases on page 14. Do not link the database.

2 On the utility server, use the Configuration Manager to set up a client configuration for the new
site (named IN using our example), using the steps under Creating additional client configurations
on page 20.

3 Apply the same patches to the new database that have been applied to the other databases in the
shared intranet.

4 If you have UETs defined at other sites in the shared intranet, ensure that the same UET schema
changes are made in the new site.

5 Use the Trigger Management form to regenerate triggers for all tables in the new site.

6 Follow the other steps in Setting up the utility server on page 19 to perform these tasks:

a Use the Configuration Manager to set up any new web servers or configuration groups needed
for the new configuration.

b Use the Service Configuration Manager to add event monitoring for the new configuration, if
needed.

c Use the Service Configuration Manager to add TaskMan monitoring for the new configuration.
d Stop and restart the Infor services so they are aware of the new configuration.

7 Log into the new site (IN), using the SQL sa user name and password.

8 In the new site (IN), open the License Management form and apply the license. (If you are using
Intranet Licensing for your shared intranet, skip this step.)

9 In the new site (IN), open the Sites/Entities form and look at the existing record for this site (IN).
The record should include the time zone, an intranet name (probably Demo if this is a new site), a
database name, and a forms database name.

10 In the new site (IN), in the Sites/Entities form, add site records for all sites that already exist on the
shared intranet. In our example, you would add records for OH, MI, and CA.

Note:  In the records for the other sites, only specify a Time Zone. Any information in these records
will be overwritten later, when you run manual replication. See the information about manual
replication in Adding a site or entity to an existing shared tables intranet on page 101.

11 In the master site (OH in our example), open the Sites/Entities form and add a site record for the
new site (IN). In this record, specify exactly the same information (Time Zone, Intranet Name,
Database Name, etc.) that is displayed in the IN record at the IN site.

12 In the master site (OH), in the Sites/Entities form, add Link Info for each site. For example, the Link
Info for the master (OH) site record looks like this:

a In the master site (OH in our example), open the Sites/Entities form and add a site record for the
new site (IN). In this record, specify exactly the same information (Time Zone, Intranet Name,
Database Name, etc.) that is displayed in the IN record at the IN site.
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b In the master site (OH), in the Sites/Entities form, add Link Info for each site. For example, the
Link Info for the master (OH) site record looks like this:

Linked Server NameTo Site

usserver1\slutilCA

usserver2\slutilIN

usserver1\slutilMI

The Link Info for the CA site record looks like this:

Linked Server NameTo Site

usserver2\slutilIN

usserver1\slutilOH

usserver1\slutilMI

The Link Info for the MI site record looks like this:

Linked Server NameTo Site

usserver1\slutilCA

usserver2\slutilIN

usserver1\slutilOH

The Link Info for the new site record (IN) looks like this:

Linked Server NameTo Site

usserver1\slutilCA

usserver1\slutilMI

usserver1\slutilOH

Note:  Do not manually update the site records at any of the other existing sites on the intranet.

13 In the master site (OH), add a replication rule to send Site Admin data to the new site (IN).
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14 In the master site (OH), open the Replication Management form and regenerate replication triggers.

15 In the master site (OH), open the Manual Replication Utility and send all Site Admin data from
the master site (OH) to the new site (IN). Clear the Local Site Data Only field.

16 In the new site (IN), open the Sites/Entities form and verify that the site records for the other sites
(OH, MI, and CA) were updated.

17 In the new site (IN), open the Intranet Shared Tables form and verify that tables that are shared
in the other sites now appear to be shared in this site.

Note:  Although the tables appear to be shared, they are not actually shared until after you complete
step 18.

18 In the new site (IN), open the Sites/Entities form and change the Intranet Name to the shared
intranet’s name.

After you select the intranet, you will see this message:

At least one Intranet Shared Table where Shared is Yes exists for Intranet
that has [Intranet: name]. Processing may require a significant amount of
time.

Click OK and save the record.

During the process, several Replication Triggers Regenerated messages are displayed.

19 Use the View Management and Trigger Management forms at each site and entity to regenerate
the views and table triggers.

20 In the database server for the new site (IN), verify that the shared _all views have been created and
the shared _all tables no longer exist:

Infor CloudSuite Business Multi-Site Implementation Guide | 104

 

Adding a site or entity to an existing shared tables intranet



Note:  Depending on your setup, some _all tables might be shared, and others might not be shared.
In that case, you will still see some _all tables in the Tables node, but the shared _all tables should
not be listed.

21 At this point, you can set up other replication rules in the new site (IN) to/from other sites in the
intranet. See Setting up replication at sites on page 30.

22 Regenerate the replication triggers after adding the rules.

23 At the new site or entity, follow the steps in Setting up accounts and financial reporting hierarchies
on page 52 to set up the site’s accounting and reporting information:

• For new sites that report to an existing entity, the chart of accounts and accounting periods should
be automatically replicated. In order for this to occur, these conditions must be met:

• The hierarchy between the site and entity must be set up as described in Setting up accounts
and financial reporting hierarchies on page 52.

• The Ledger Consolidation rule must be set from the entity to the site, and the GL Replication
rule must be set from the site to the entity, and replication triggers must be regenerated.

• Manual replication of Ledger Consolidation from the entity to the site, and manual replication
of General Ledger from the site to the entity, must be processed.

• For new entities, the chart of accounts and accounting periods must be copied manually as
described in Setting up accounts and financial reporting hierarchies on page 52.

• If some existing sites will report to a new entity, use the Change Reports To Entity utility at
those sites to specify the new reporting hierarchy. Do this after performing all of the other steps
in Setting up accounts and financial reporting hierarchies on page 52 and - if there are now
multiple levels of entities - after specifying the CTA account information at the corporate (top-level)
entity as described in Setting general parameters on page 60.

24 Follow the steps in Chapters 8-12 to finish setting up the new site or entity. You will probably be
copying much of the data from existing sites.

• On the Inter-Site Parameters form, if appropriate, set up relationships between the new site
and the other existing sites that will be transferring items or material to/from the new site. If Site
Admin is being replicated, this information will be added automatically at the other sites.

• On the Order Entry Parameters form, set the invoice length to match the length set at the other
sites.
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Adding an existing site or entity to an existing system
(one site per database)
To add a site/entity with existing data to an existing multi-site system, follow these steps. See the
relevant chapters in this guide or the online help for additional details about any step.

Before you start:

• Back up all existing databases before starting this process.
• If the existing site currently reports to an entity and will report to a different entity after moving, think

carefully about the implications.
• If the site previously did not report to an entity, but it will now, you must ensure that the site’s currency,

chart of accounts, and so on, match those at the entity.
• See the information in the Multi-Site Planning Guide about entities and reporting structures, especially

the information on changes to reporting structures.

1 If the site currently is part of another multi-site CloudSuite Business system, follow the steps in
Removing a site from an existing system on page 98. Then return to this topic and complete the
rest of the steps.

2 Follow steps 9 through 16 under Adding a new site or entity to an existing system (one site per
database) on page 102; then return to this process.

3 To synchronize customer and vendor information at sites:

a Using SQL queries, find existing vendors and customers in the newly added site that have
matching numbers but different names in existing sites.

b At the added site, use the Move Local Customers and Move Local Vendors utilities to change
customer and vendor numbers at this site to match the number used at existing sites in this
multi-site system. See the online help on these forms for more information about how to use
them.

c If you ran the Move Local Customersutility in the previous step, run the Rebalance Customer
Balances utility to update the customers’ posted balance and order balance.

4 Set up replication rules between the new site/entity and the other sites and entities. For more
information, see Setting up replication at sites on page 30

5 Regenerate the replication rules at all sites and entities.

6 In all sites that are sharing customers and vendors, use theManual Replication Utility to replicate
a category that contains vendaddr_mst and custaddr_mst. This populates the customer and vendor
records in all sites that are sharing customers and vendors with the added site.

7 If the added site or entity will report to an entity in its new structure, perform these tasks:

a If chart records exist at the added site/entity that do not exist at the entity it will report to, add
those records to the financial entity.

b Run the Change Reports To Entity utility at the added site/entity:

• You can only change the Reports To Entity to a financial entity that has the same base
(domestic) currency, Chart of Accounts and accounting periods. Also, the system verifies that
all accounts defined at the site already exist at the financial entity. If this validation fails, the
change will not be allowed and a report is created detailing the failures.

• If no Chart of Accounts, financial statement account templates, or accounting periods have
been set up yet at the site, this Change Reports To Entity utility will copy them from the
entity to the site.
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c Run Ledger Consolidation (again) at each site and entity in the new structure. This consolidates
the beginning balances for each account up through the new financial entity hierarchy.

8 If you are adding an entity, use these steps:

a If chart records exist at the existing site/entity that do not exist at the added entity they will report
to, add those records to the entity.

b Run the Change Reports To Entity utility at the sites that will report to this entity, specifying the
name of this added entity.

• You can only change the Reports To Entity to a financial entity that has the same base
(domestic) currency, Chart of Accounts and accounting periods as the site. Also, the system
verifies that all accounts defined at the site already exist at the financial entity. If this validation
fails, the change will not be allowed and a report is created detailing the failures.

• If no Chart of Accounts, financial statement account templates, or accounting periods have
been set up yet at the site, this Change Reports To Entity utility will copy them from the
entity to the site.

c Run Ledger Consolidation (again) at each site/entity in the new structure. This consolidates
the beginning balances for each account up through the new financial entity hierarchy.

Adding a new site into an existing database (multiple
sites per database)
See Adding new sites and entities to an existing application database on page 16.
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Appendix F: Copying an existing site into an existing
database (multiple sites per database)

Before you start this process, consider this information:

• If you have custom tables in your existing sites (possibly created with the SQL Tables form in a
previous version of CloudSuite Business), they will be copied, but they will not be changed to
multi-site tables. That is, the table name is not changed to xxx_mst, no view is created over the
table, and no multi-site column is added to the table. If you want a custom table to be multi-site,
create and run a script to perform the conversion.

For more information about the required schema conversions, see the white paper Coding and
Schema Changes Made in SyteLine 9.00 for Multiple Sites per Database.

• Tables or columns that exist in the source must also exist in the target database. So if you have
custom tables or columns in the source, you must ensure that they are added to the target.

• Use the Analyze Only option (described later) to find additional potential problems that you must
address before you perform the copy. If you do not find and correct these problems, and the copy
process hits a validation error, the copy process is aborted.

• Do you have replication document metadata (that is, records in the Replication Documents form
and related forms) that has been customized or revised from the standard Infor metadata? If so, be
aware that this process copies replication document metadata only into a target database that does
not contain any replication document metadata. This could be an empty target database, or a target
database that is emptied during the site copy process, or a target database where all replication
document metadata has been removed.

If replication document metadata exists in the target database, then use the App Document Metadata
Sync utility as described in Step 13.

• The Infor CPQ (formerly BuyDesign) configuration output tables are excluded from this process and
are not copied to the target database by the Infor CloudSuite Configuration Wizard. Run the Infor
Product Configuration Management Configurator Output Database Copy Utility after the Infor
CloudSuite Configuration Wizard has successfully completed the copy process. For more information
about this utility, see KB article 1549052 on Infor Xtreme.

Steps
To copy an existing site from a (source) application database into another (target) application database:
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1 Disable any replication to the source site for the duration of the copy process. Prevent users from
accessing or making any changes in the source and target databases during the copy.

2 Open the Configuration Wizard.

3 Select Add New Site to an Existing Database and click Next.
4 In the Select Source Site Type dialog box, select Database and specify the SQL information about

the source database and site.

5 Click Next.
6 In the Set the Target Database Information dialog box, specify the SQL information about the

target application database into which the site will be copied.

7 Select Analyze Only to compare the two databases (source and target) to identify any problems
that might occur during the copy. See Validations on page 110 for a list of possible problems to be
addressed.

8 Select Delete Target Database Data only if you want to empty the data from the specified target
database. This is only necessary if you copy a site within a non-partitioned application database
that contains installed, upgraded add-ons, third-party applications, or other customizations to a
target application database that contains no sites, in order to create a partitioned target application
database.

9 Click Next to review changes.

10 Click Commit and then click Finish. Review the log file for analysis results.

11 
12 After any problems are resolved, repeat the steps above and clear Analyze Only so the copy can

be performed. See What is copied on page 111 for a list of the types of information that is copied,
and exceptions that are not copied.
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13 Click Next and then Commit to complete the process.

14 The utility copies replication document metadata from the source to the target only if the target
database does not currently contain any replication document metadata. Otherwise, use the App
Document Metadata Sync utility on the utility server to export replication document metadata from
the source database and import it into the target database. In the first screen, select both the Base
SyteLine and Core Access As values. In the second screen, select Replication Documents.
Password parameters are copied from the source database to the target database if the target
database is empty (and therefore does not include password parameters).

15 Redefine any Full Text Indexes on tables in the target database.

16 Verify that the site in the target database is working properly and all data was copied correctly. Then
you can delete or archive the source database. Note: This step assumes that the source database
contains only one site. If the source database has multiple sites, you cannot delete or archive one
site from the database

17 After you perform this procedure, you might need to re-license the target database, depending on
how the source site was originally licensed. Here are some examples where re-licensing might be
required:

• If Intranet Shared Licensing is used, the target database looks to the master site for licensing. If
the master site is being moved into the target database, the target database must now be licensed.

• Named user licensing was used at the source site, but concurrent licensing is used in the target
database.

• The source was defined as an "entity" database, but the target database currently contains only
"sites" and is not licensed for "entities.”

See the Infor CloudSuite Business Licensing Administration Guide for more information about
licensing setup.

Validations
During the copy process, these areas of validation are performed:

• Is the target database partitioned? If not, in the target (empty) database, foreign keys are dropped,
the partition function is created, partition scheme is created, multi-site tables are partitioned using
the partition scheme, and foreign keys are recreated. If the target database is already partitioned,
the partition scheme and partition function are updated for the site that is being added.

• If user table or _All table sharing is enabled for either the source or target database, then the source
site and all sites in the target database must be on the same intranet. Otherwise, the process is
aborted.

• Table compatibility:
• If a table exists in the source database, but a table with the same name does not exist in the

target database, the process is aborted.
• If a table exists in the target database, but a table with the same name does not exist in the

source database, a warning is logged but the process continues.

• User Extended Tables (UET) compatibility:
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If the Source and Target databases both have UET data, verify its compatibility. If these areas
are not compatible, the process is aborted:

•

• For fields, no differences in data type, decimals, user-defined datatype, and precision.
• For indexes, no differences in index uniqueness specification or fields.
• No difference in fields associated with a class.
• For table classes, no differences in table_rule, extend_all_recs, allow_record_assoc, and

active values.

• If the Target database has UET data that is not impacted, the process is aborted.
• If there is a unique UET index on a _mst table, the copy process is aborted. You must add the

Site Column Name to the index. (If you plan to later add a unique UET index in this _mst table
with UET fields, you must manually add the site_ref column to this index.)

• If any Application Event System events are actively running or queued in the source database, the
process is aborted. The events are listed in the error messages with the name of the event, the IDO,
the table, and the RowPointer.

• If any differences are found in these areas for Application Event System events, a message is logged
but the process continues:
• Differences in values for matching EventHandler records
• Differences between any matching EventAction values
• Event actions that exist for a handler in the source, but not in the target, or vice versa
• EventActionVariableAccess values that differ between the source and target
• For an event, sequence, event action sequence, and variable name, any rows that exist in the

source, but not in the target, or vice versa
• Table names that start with “Import” and table names that contain “SourceDL” or “TargetDL” are

excluded from the process.

What is copied
During the process, this data is copied from the source to the target database:

• UET definitions. Only the impacted schema changes are copied. If the source database has UET
data that has not been impacted, it is not copied. The schema is impacted at the target if necessary.
(For validation information, see Validations on page 110.)

• All multi-site tables except AccountAuthorization_mst, user_local_mst, and UserGroupMap_mst. If
these three tables are not shared, then they are copied like any other multi-site table. If these tables
are shared, they are processed like other user tables, based on the type of sharing being done (see
below).

• All non-multi-site tables. Some tables require special processing:
• Notes: Internal token numbers that overlap are renumbered. If the same note text exists in both

the source and target databases, after the copy there are duplicate notes in the target.
• Documents: Sequence numbers that overlap are renumbered.
• Service schedules (see above for validation information)
• Application Event System data:

• New Event rows are copied from source to target
• New EventMessageCategory are copied from source to target
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• New EventInitialState rows are copied from source to target
• If anything is different in EventInitialVariables for an existing EventInitialState record, the state

is renamed when it is copied to the target. For example, xxx becomes xxx2. The copied event
handlers are also changed to use the new initial state name.

• New EventInitialVariable are copied from source to target, as well as existing rows that required
a newly renamed EventInitialState record.

• Users and Groups: What is copied depends on the type of sharing, if any, currently being done
between the source site and the target database:
• No sharing of user tables between source and target: for tables where UserId is part of the

unique key, copy the unique records; if duplicate user IDs exist, use the record from the target.
• If all sites are on the same intranet, the source site is a subordinate site and the target database

contains a master site: For tables where UserId is part of the unique key, copy the unique
records; if duplicate user IDs exist, ignore the duplicates, remapping UserId during the process
for comparison.

• If all sites are on the same intranet, the source site is the master site, and the target database
contains only subordinate sites: Drop the view in the target database, and copy the source
table into the target database. For tables where UserId is part of the unique key, copy the
unique records; if duplicate user IDs exist, ignore the duplicates, remapping UserId during
the process for comparison.

• If all sites are on the same intranet, the source site is a subordinate site, and the target
database contains only subordinates sites: For tables where UserId is part of the unique key,
copy the unique records; if duplicate user IDs exist, ignore the duplicates, remapping UserId
during the process for comparison.

• UserPasswordHistory: If users are shared, this table is always shared. If users are not shared,
and the user already exists in the target database, the history is not copied. If the user does not
exist in the target database, the history is copied.

• Replication document metadata is copied from the source to the target only if the target database
does not currently contain any replication document metadata.

• Custom (non-CloudSuite Business) tables, either multi-site or not multi-site. To copy a non-multi-site
custom table, the copy process requires a unique constraint on the table, and it tries to move any
data from the source to the target that does not already exist in the target, based on this constraint.

• Updates site.app_db_name to the database name of the target database
• Updates site_link_info.linked_server_name to the server name of the target database for all rows

where site_link_info.to_site = site being moved

Data within some tables, for example AuditLog, BGTaskHistory_mst, and tables whose names start
with "import" is not copied with this process.

If the source site is in a database that contains other sites, the data is filtered so that only the specified
site’s data is copied.
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Appendix G: Copy User Tables utility

This utility copies user data and authorizations from one CloudSuite Business database to another
CloudSuite Business database. This can save time in setting up users in the additional databases.

If your target database is multi-site, the utility copies user data and authorizations to the database. For
shared user tables that end with _mst (that is, AccountAuthorizations_mst, UserGroupMap_mst, and
User_local_mst) one copy is made to the master site. For non-shared user tables that end with _mst,
a copy is made for each site in the database. Other user tables (UserNames, UserEmail, GroupNames,
UserModules, and UserDefinedFields) are also copied. For exceptions to this, see How the utility
handles shared user tables on page 116.

The UserTables.txt file in the SyteLine folder on the utility server is provided by Infor. This file lists
tables that are commonly copied by this utility. The Copy User Tables utility refers to this file to determine
which tables to copy. You can edit this file to remove tables from the list if you do not want them to be
copied by the utility. Adding tables to the list is not supported.

Caution:  If any users are already defined in the target database, those users are deleted by this
utility. Any foreign key references are also deleted. Therefore only use this utility in these cases:

• You have created a new demo or initialized database, and you want to copy all user data and
authorizations from a site in an existing database to sites in the newly created database.

• You have a pilot database (for example, Phase 1 Pilot). In Phase 2 Pilot testing, you want to replace
the entire Phase 1 Pilot database with fresh data. However, you want to copy the user data from
the Phase 1 Pilot database into the Phase 2 Pilot database, so that you do not have to re-enter all
of the user information.

• You have a test database with a limited set of users who can access it, but the test data has become
stale or corrupted. You want to copy a "live" production database to create a new version of the test
database, but you do not want to allow all of the users in the production database to access the test
database. You can use this utility to wipe out the user information in the copy, and replace it with
the user data from the previous test database.

Using the utility
1 To open the utility on a utility server, select Apps > Copy User Table. Run the utility as an

administrator.

2 On the Source tab, specify the SQL server, SQL login ID and password to access the source
database.

Infor CloudSuite Business Multi-Site Implementation Guide | 113

 

Copy User Tables utility



3 Select the source database. This must be a CloudSuite Business application database, version
9.00.xx or above.

• If the source database is not sharing user tables, you can select any site in that database as the
source for the copy.

• If the source database is sharing user tables and the master site is not in that database, an error
message is displayed and you must select a different source database.

• If the source database is sharing user tables and the master site is found in the database, the
message Intranet Shared User Tables detected is displayed.

If you get this message, click OK. Note that the status field is updated.

4 If this is a multi-site source database, select the source site. If there is a master site, only the master
site can be selected.

If this is a single-site source database, the source site is selected by default.

5 On the Target tab, the SQL server name, login ID and password values are populated from the
previous tab, but you can change them.

6 Select a target database. This must be a CloudSuite Business application database, version 9.00.x
or above. It cannot be the same database as the source database.

• If the target database is sharing user tables and the master site is not in that database, an error
message is displayed and you must select a different source database.

• If the target database is sharing user tables and the master site is found in the database, the
message "Internet Shared User Tables detected" is displayed. If you get this message, click OK.
Note that the status field is updated.

• If this is a multi-site target database that is sharing user tables, only the master site is displayed
and selected in the Target Site field.

• If this is a single-site target database, the target site is selected by default.
• If this is a multi-site database that is not sharing user tables, all of the sites that will receive the

copied user data are listed.

In this example, SP_20_Midwest_App is a multi-site database with two sites, MI and OH:

Infor CloudSuite Business Multi-Site Implementation Guide | 114

 

Copy User Tables utility



7 In the Login tab, specify a CloudSuite Business user ID, password, and the name of any CloudSuite
Business configuration in the target database.

8 Click Copy.

The Dropped UserModules Records field is only populated when a license is in place. It lists the
UserModules records that exceeded the license and that had to be dropped.
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Troubleshooting the Copy User Tables utility

UsernamesColumns.count does not match between databases

If you get an error similar to this, the schema of the specified table is different in the source and target
database. One of the tables has additional columns.

ExecuteNonQuery failed for Database ‘dbname’

If you get an error similar to this, ensure that you have set up a configuration that matches the name
specified in the Data Source Config field.

How the utility handles shared user tables
There are several different options for setting up user table sharing on the Intranet Shared User Tables
form. The Copy User Tables utility checks to see if any of these tables are shared in either the source
or target database:

• AccountAuthorizations_mst
• UserGroupMap_mst
• User_local_mst
• Other user tables (UserNames, UserEmail, GroupNames, UserModules, and UserDefinedFields)

If any of these tables is shared in the source database, then only the master site in that database can
be used as the source site for the copy utility.

The sharing setup in the target database determines which tables are copied to which sites in the target
database. In the scenarios below, the database pictures show any shared tables across the top.

• All user tables are shared in a target database with a master site.

If all of the user tables listed above are shared, and the master site is in the target database, the
utility copies the user tables only to the master site in the target database.

• _mst user tables are not shared in the target database.

If the three _mst user tables listed above are not shared in a multi-site target database, then the
utility copies those user tables to each site in the target database.
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• User_local_mst is not shared in a target database with a master site.

If AccountAuthorizations_mst and UserGroupMap_mst are shared, but user_local_mst is not shared
in a multi-site target database with a master site, the utility copies just the user_local_mst user table
to each site in the target database. AccountAuthorizations_mst and UserGroupMap_mst are only
copied to the master site. The other user tables are copied to the database.

• User_local_mst is not shared in a target database with no master site.

If you attempt to copy user tables into a target database that is sharing user tables, but the master
site is not in that target database, an error will occur.

In order to copy user tables into this target database, you must first turn off the sharing of user tables
in the master site, use the copy utility to copy the users to the target database, and then turn sharing
back on.
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Appendix H: Upgrading a multi-site system

To upgrade from CloudSuite Business version 7 or 8, see the Infor CloudSuite Business Installation
Guide chapter on upgrading an CloudSuite Business database. Follow the steps in that chapter to
upgrade each of your application databases.

To migrate an CloudSuite Business version 5 or 6 multi-site environment to Infor CloudSuite Business
9, see the Infor CloudSuite Industrial Installation Guide chapter on migrating from CloudSuite Business
5 or CloudSuite Business 6 (multi-site). Follow the steps in that chapter to migrate each of your
application databases.

Note:  If you plan to keep all of your sites in separate databases, then stop here and do not continue
with the next steps.

Converting a multi-site, multi-database system to a
multi-site, single database system
After you read the information in the Infor CloudSuite Business Multi-Site Planning Guide, if you want
to convert from a multi-site, multi-database system to a multi-site, single database system, use these
steps:

Note:  SQL Server Enterprise Manager must be installed on the target database server.

1 If you are on a previous version of CloudSuite Business, upgrade each of your site databases to
the current version (CloudSuite Business 9.00 or above). See the Installation Guide for instructions.

2 If you have any business partner add-on products, upgrade those products on each of your site
databases. See the appropriate product guide for instructions.

3 On the target database server, use the CloudSuite Business Configuration Wizard to create a new,
empty application database that will contain the sites and entities in your new multi-site, single
database system. This database is automatically partitioned when it is created.

4 Follow the steps in Copying an existing site into an existing database (multiple sites per database)
on page 108.

5 After all sites are copied, use the View Management and Trigger Management forms to regenerate
the views and table triggers in all application databases.
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Appendix I: Changing the master site

These steps assume the following:

• Multiple existing sites all on one intranet, where Site A is the current master site and Site B is another
existing site in a different database on the same intranet.

• You want to switch the master site to Site B.

Follow these steps:

1 Ensure that all users are logged out.

2 At Site A, unshare any _all or user tables that are shared. Keep a record of the tables that you are
unsharing. See the help topic "Unsharing Multi-Site Shared Tables."

This could take a long time.

Note:  If all sites are in one database, you can skip this step.

3 In the Intranets form at Site A, set the Master Site to blank.

4 In the Intranets form at Site B, set the Master Site to Site B.

5 At Site B, share any _all or user tables that were previously shared with Site A.

This could take a long time.

6 On the Trigger Management form at both sites, regenerate replication triggers.

7 Flush the cache.

Verification: If sites are not in the same database, and sharing of _all tables or user tables is in place,
verify that the data in user tables at the master site is updated when data is updated in the subordinate
sites. Also ensure that views are set up appropriately within the databases.
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